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I 1 General Information

Read through this operating manual carefully before use and become familiar with the product.
Installation and start-up should not be carried out before reading and understanding this
document. Keep this manual readily available so that you can reference it as needed.

1.1 What Is the Purpose of this Operating Manual?

This manual serves as an aid for the installation and operation of the product and supports the
technical staff with all operating and maintenance tasks to be performed. Furthermore, this
manual is aimed at preventing dangers to life and health of the user and third parties.

1.2 Who Is this Operating Manual Targeted to?

The operating manual provides a code of conduct for personnel tasked with the setup,
operation, maintenance, and repair of gas engines. A certain level of technical knowledge with
respect to the operation of gas engines and basic knowledge of electronic ignition systems are
necessary. Persons who are only authorized to operate the gas engine shall be trained by the
operating company and shall be expressly instructed concerning potential hazards.

1.3 Which Symbols Are Used in the Operating Manual?

The following symbols are used in this manual and must be observed:

Example

This symbol indicates examples, which point out necessary handling steps
and techniques. In addition, you receive additional information from the
examples, which will increase your knowledge.

EXAMPLE
® Notice
This symbol indicates important notices for the user. Follow these. In
addition, this symbol is used for overviews that give you a summary of the
NGEICE necessary work steps.

Warning

This symbol indicates warnings for possible risks of property damage or
risks to health. Read these warning notices carefully and take the
mentioned precautionary measures.

8 Rev. 09/2019



I 1 General Information

DANGER

Danger

£ MOTORTECH

This symbol indicates warnings for danger to life, especially due to high
voltage. Read these warning notices carefully and take the mentioned

precautionary measures.

1.4 Which Abbreviations/Acronyms Are Used in the Operating Manual?
In the manual or the user interface, the following abbreviations / acronyms are used.

Abb.
ADV

ASO

ATDC
BTDC

CAN bus

CE

CPU

°crankshaft

CSA

DC

DetCon

Rev. 09/2019

Term Description

Advance Advanced with
respect to top dead
center

Auxiliary

Synchronization

Output

After Top Dead Center

Before Top Dead
Center

Bus for control
devices / networks

Controller Area
Network bus

Conformité
Européenne

Conformity with EU
directives

Central Processing
Unit
Degree crankshaft

Canadian Standards
Association

Direct Current

Detonation Control
System

Explanation

Indicates the direction for
timing

Output for synchronizing the
MIC6 and other controllers

Asynchronous serial
connection system for linking
control units

Mark based on EU legislation
for certain products in
conjunction with product safety

Unit for the rotation angle of
the crankshaft

Organization that defines
standards, inspects products
for safety compliance, and
issues pertinent certifications.

Serves to prevent major engine
damage that can be caused by
knocking combustion.



I 1 General Information

Abb. Term Description Explanation
EMI Electromagnetic
Interference
EMC Electromagnetic Compatibility of electrical or
Compatibility electronic equipment items
with their surroundings
GPI General Purpose Input  Multi-purpose input
GPO General Purpose Multi-purpose
Output output
HV High Voltage
1SO International

Organization for
Standardization

LED Light Emitting Diode Light emitting electronic
semiconductor
MIC MOTORTECH Ignition
Controller
MICT MOTORTECH Software for the configuration
Integrated of the MIC6

Configuration Tool

MOSFET Metal Oxide Semiconductor component
Semiconductor Field-
Effect Transistor

RET Retard Retarded with Indicates the direction for
respect to the top timing
dead center

RS485/ Recommended Industrial standard for a
TIA485 Standard 485/ physical interface for
Telecommunications asynchronous serial data
Industry Association transfer
485
TDC Top Dead Center
USB Universal Serial Bus Serial connection system to
link a computer to external
devices
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2.1 General Safety Instructions
The following safety instructions must be followed in the area in which the device is operated:

High voltage! Danger to life!

While the engine is running, the area around the ignition system especially
holds the risk of danger due to high voltage. The following parts should
therefore not be touched or removed unless explicitly stated otherwise:

DANGER

- Ignition coils and caps

— Wires of the high voltage circuit

- In- and output wiring of the ignition controller

- Pickups and their wiring

Danger to persons with pacemakers!

Electromagnetic impulses in the wiring of the ignition system may exceed

the permissible limits of pacemakers. Persons with pacemakers must
TR therefore not be present in the vicinity of the ignition system being

operated. Mark the operating location of the ignition system with the
corresponding standardized warning symbol.

MOTORTECH equipment is manufactured as state of the art and therefore safe and reliable to
operate. Nevertheless the equipment can cause risks or damage can occur, if the following
instructions are not complied with:

- The gas engine must only be operated by trained and authorized personnel.

— Operate the equipment only within the parameters specified in the technical data.
- Use the equipment correctly and for its intended use only.

- Never apply force.

— Forall work such as installation, conversion, adaptation, maintenance, and repair, all
equipment must be disconnected from the mains and secured against unintentional
reactivation.

- Perform only such maintenance and repair work as is described in this operating manual,
and follow the instructions given while working.

- Only use spare parts supplied by MOTORTECH for the maintenance of the device.

- Further work must only be performed by personnel authorized by MOTORTECH. Non-
compliance with the instructions will void any warranties for the proper function of the
equipment as well as the responsibility for the validity of the certifications.

- Safety devices must not be dismounted or disabled.

— Avoid all activities that can impair the function of the equipment.

Rev. 09/2019 11



2 Safety Instructions

Operate the equipment only while it is in proper condition.
Investigate all changes detected while operating the gas engine or ignition system.

Ensure compliance with all laws, directives, and regulations applicable to the operation of
your system, including such not expressly stated herein.

If the system is not entirely tight and sealed, gas may escape and result in explosion hazard.
The inhalation of gas can also lead to death or severe health damages. Therefore, upon
completion of all assembly works, always check the system's tightness.

Always ensure adequate ventilation of the engine compartment.
Ensure a safe position at the gas engine.

There is a risk of burning on hot surfaces. Allow the engine to cool down before starting any
work.

Personal protective equipment (PPE), e.g. safety shoes and gloves, must be worn during all
work on the engine.

Your behavior can reduce possible residual risks to a minimum. Observe responsible
handling of the gas engine and the gas-carrying system.

2.2 Electrostatic Discharge Hazards

Electronic equipment is sensitive to static electricity. To protect these components from damage
caused by static electricity, special precautions must be taken to minimize or prevent
electrostatic discharge.

Observe these safety precautions while you work with the equipment or in its vicinity.

Before performing maintenance or repair work, ensure that the static electricity inherent to
your body is discharged.

Do not wear clothing made from synthetic materials to prevent static electricity from
building up. Your clothing should therefore be made of cotton or cotton mix materials.

Keep plastics such as vinyl and Styrofoam materials as far away from the control system, the
modules, and the work environment as possible.

Do not remove the circuit boards from the housing of the device.
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2.3 Information on Electric Isolation
If ground and earth potential are not properly isolated, the following problems as well as others
can occur:

- Electromagnetic interferences (e.g. ground loops)

- Signal corruption (e.g. of the analog voltage signal)

— Unwanted leakage currents

Therefore, earth potential and the negative pole of the power supply of all devices in the electric
assembly that provide the option, should be connected separately. If possible, the negative pole

of the power supply should only be connected to earth potential at one point in the entire
system.

Wiring Example

Device with Device featuring
shielded wires protection class Il
5]

ny
g

=

L+
24V DC

. 1
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Occurrence of ground loops

The devices shown in the following image do not feature the possibility to
connect the earth potential and the negative pole of the power supply
separated from each other. How ground loops are created.

A ground loop is a ground connection of an electric wiring assembly that is
closed as a loop. Due to impedance (resistance R » 0) of the loop, low-
frequency interference currents can lead to an unwanted voltage drop in the
signal path.

Device 1 Device 2
(D D)
II R II

|
B | Il
Ground loop

Rev. 09/2019
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£ MOTORTECH

2.4 Special Safety Instructions for the Device

DANGER

Rev. 09/2019

Danger to life! Hazardous residual voltage!

After stopping the ignition, there is dangerous residual voltage for up to
three minutes in the ignition system. Do not touch any components of the
ignition kit during this time.

Explosion hazard!

If the system is located in a hazardous area, never open the device (e. g. by
opening the service screw or removing covers). There is a risk of explosion.

Explosion hazard!

The replacement of parts or assemblies can impair compliance with CSA
Class I, Division 2 (Group C, D), T3C.

Explosion hazard!

Do not disconnect any connectors while the system is live. If the system is
located in a hazardous area, there is a risk of explosion.

Explosion hazard!

Never remove the equipment while the unit is connected to a power source.
If the system is located in a hazardous area, there is a risk of explosion.

Explosion hazard!

Do not remove or replace the fuse while the equipment is live.

15
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Risk of burning!

The surfaces of the system may heat up to high temperatures.

Operational safety!

All connector screws and screw joints must be adequately tightened. Refer
to the section Mechanical Data on page 20.

Operational safety!

The proper functioning of the device is only guaranteed if the device is
operated within the permissible supply voltage range. Therefore, use a
power supply in accordance with the specifications in the operating
manual.

Risk of destruction!

Magnetic fields and heat occur when welding, which may damage or
destroy the MIC6. Therefore, pay attention to the following when welding:
— Disconnect all electrical connections to the MIC6 prior to welding.

— Protect the MIC6 against direct contact with the welding unit and
magnetic fields, sparks and liquid metal.

2.5 Proper Disposal

After the expiration of its service life, MOTORTECH equipment can be disposed of with other
commercial waste, or it may be returned to MOTORTECH. We will ensure its environmentally
friendly disposal.
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3.1 Functional Description
The devices of the MIC6 series are microprocessor controlled ignition systems, each consisting
of a board with a 32 bit main processor (CPU).

Please note that the manufacturer is not required to implement configurations of the ignition
controller for specific engines, and that devices may be delivered without pertinent
configuration.

The ignition controllers of the MIC6 series use information supplied by the pickups to precisely
determine the correct timing for the respective outputs. The pickups can be assigned to two
redundant sets of pickups depending on the device version. The ignition timing is influenced by
various inputs. This can be implemented using analog input signals, a speed characteristic, or
using a serial interface (USB, CAN bus, RS485).

During operation, the ignition controllers continuously monitor the system status of all installed
pickups and the correct operation of the primary ignition circuit by checking the information
received.

Depending on the severity of an error that is detected, the device will shut down immediately or
warn the operator. A corresponding message can be viewed on a connected computer.

To protect the engine, the ignition controllers additionally have an adjustable overspeed shut-
off.

3.2 Applications

The ignition controllers of the MIC6 series are designed for specific 2- or 4-stroke gas engines.
From 1 to max. 24 ignition outputs are available. The device variants are intended for the
following use:

— MICé6: stationary gas engines

- MIC6-Marine: gas engines on ships

The ignition controllers supply the energy required for the corresponding ignition coils of the
gas engines and can supply signals for peripheral equipment.

Any use other than the one described in the operating manual shall be considered improper use
and will result in the voiding of all warranties.

Rev. 09/2019 17
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4.1 Technical Data

4.1.1 Certifications
The ignition controllers of the MIC6 series are certified as per the following
directives/regulations:

CE

EMC Directive 2014/30/EU

EN 61326-1:2013 - Electrical equipment for measurement, control and laboratory use.
EMC requirements. General requirements

EN 55011:2009 + A1:2010 — Industrial, scientific and medical equipment. Radio-
frequency disturbance characteristics. Limits and methods of measurement

EN 61000-6-2:2005 — Electromagnetic compatibility (EMC). Generic standards. Immunity
for industrial environments

EN 61000-6-4:2007 + A1:2011 — Electromagnetic compatibility (EMC). Generic standards.
Emission standard for industrial environments

Low Voltage Directive 2014/35/EU

EN 61010-1:2010 — Safety requirements for electrical equipment for measurement,
control, and laboratory use. General requirements

EN 60529:1991 + A1:2000 + A2:2013 — Degrees of protection provided by enclosures (IP
Code)

RoHS Directive 2011/65/EU

CSA Std C22.2 No. 0 -10

CSA Std C22.2 No. 142-M1987 (R 2004)
CSA Std C22.2 No. 213-M1987 (R 2004)
ANSI/ISA 12.12.01, Ed. 1 (2007)

UL Std No. 916, Ed. 3 (1998)
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I 4 Product Description

Further Approvals for Ignition Controller of the MIC6-Marine Series

1R

TYPE APPROVAL
SCHEME

[a]
w
>
o
e
o
o
<

Lloyd's Register (LR)

@OVED p,
W #oy,

%

>

Ty&é\

DNV GL

MARITIME

DNV GL

Bureau Veritas (BV)

American Bureau of Shipping (ABS)

The certificates are included on the storage device enclosed with device.

Rev. 09/2019
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I 4 Product Description

4.1.2 Mechanical Data
The MIC6 has the following mechanical characteristics.

Feature Value

Dimensions 391 mm X 240 mm x 114 mm (15.39" X 9.45" X 4.48")
(length x width x height) including connectors
MIC6-Marine:

Width x height including wire rope dampers:
311 mm x 149 mm (12.22" x 5.85")

Weight 6 kg (13.2 lbs)

Shape of device See chapter Overview Drawings on page 27
Mechanical environmental The housing is resistant to general atmospheric
conditions contaminations.

Resistant to gas engine lubricants.

Protection class: |
Protection: IP 69

The specified protection classes and types are only
guaranteed if all external wiring connections are made in
accordance with the connector specification, all covers and
seals are installed as intended and the following tightening
torques are observed:

- All Mg bolts: 0.8 Nm to 1 Nm (0.6 lb-ft to 0.7 lb-ft)
- Service screw: 2.5 Nm to 3 Nm (1.9 lb-ft to 2.2 Ib-ft)

Always use a new seal when installing the service cover.

Climatic environmental Housing surface temperature:
conditions —-40 °C to +60 °C (40 °F to +140 °F)

Max. 95 % humidity without condensation
up to 3,000 m (9,842") above sea level
Permissible vibration MIC6-Marine:
conditions — 2 Hzto 25 Hz with a maximum vibration displacement of
1.6 mm (0.06")
— 25 Hzto 1,000 Hz with a constant acceleration of 4g
MICé6:

- 2 Hzto12.4 Hz with a maximum vibration displacement
of 1.6 mm (0.06")

— 12.4 Hzto 1,000 Hz with a constant acceleration of 1g

20 Rev. 09/2019



I 4 Product Description

4.1.3 Warning Notices on the Device

Warning notice on the device

Validity of warning notices on device

German translation

£ MOTORTECH

The warning notices on the device are valid for the MIC6 and all
components connected to it.

French translation

WARNING! Read and
understand the installation
and operating manual prior to
installing or making any
adjustments.

EXPLOSION HAZARD! Do not
disconnect while circuit is
live unless area is known to
be non-hazardous. For wiring
details refer to the operating
manual.

CAUTION! Do not pressure
wash this ignition module.
Damage to electronic
components may result.

Rev. 09/2019

WARNUNG! Lesen und ver-
stehen Sie die Installations-
und Betriebsanleitung vor der
Installation und bevor Ein-
stellungen vorgenommen
werden.

EXPLOSIONSGEFAHR! Keine
Verbindungen losen, solange
der Stromkreis aktiv ist,
aufer das Umfeld wird als
nicht explosionsgeféhrdet
eingestuft. Hinweise zur
Verkabelung finden Sie in der
Betriebsanleitung.

ACHTUNG! Die Ziindsteue-
rungseinheit nicht mit Hoch-
druck reinigen. Es konnte zu
Schéden an den elektro-
nischen Bauteilen fiihren.

ATTENTION! Avant d’installer
ou d’effectuer une
modification, lisez et
comprenez le manuel
d’utilisation et d’installation.

RISQUE D‘EXPLOSION! Ne
débranchez pas lorsque le
circuit est sous tension sauf
si la zone est connue pour
étre non dangereuse. Pour
plus de détails de cablage,
veuillez consulter le manuel
d utilisation.

ATTENTION ! Ne pas laver
cette bofte de contrdle en
utilisant un jet sous pression.
Les composants électriques
peuvent étre endommagés.
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I 4 Product Description

4.1.4 Product Identification — Labeling on the Device
The necessary numbers for unique product identification are on the device:

Part number of the ignition controller (P/N)

Arrangement number of the ignition controller (A/N)

Revision number of the ignition controller indicating its precise construction status (R/N)
Serial number of the ignition controller (S/N)

= MOTORTECH"®

P/N 92.00.646-24

A/N 652.24 HOQW-000-AA-A

R/N R0101000002-01.00.00

SIN XXXXXXX

www.motortech.de

(Exemplary representation)

22
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I 4 Product Description

4.1.5 Electrical Data

£ MOTORTECH

The MIC6 has the following electrical characteristics.

Feature Value

Power consumption

Power supply

Required current
Number of outputs

Firing angles

Ignition frequency

Rev. 09/2019

Max. 270 W at 24 V

Nominal voltage: 24 V DC
Operating voltage: 16.8 VDC to 32 V DC

Max. 18 A
24 outputs

The size of the firing angle depends on the max. overspeed. The
smallest firing angle per output bank can be calculated using the
following formula:

Overspeed [min]

%0 X 360° x 2.8 ms

Ignition Angle =

With full energy output (all 24 ignition outputs with 600 m)), an
ignition frequency of 360 Hz as continuous load is possible. With
less ignition energy or in case of a brief overload (< 3 minutes),
400 Hz is possible. The maximum output load of 216 W must not
be exceeded.

2-stroke engine:

Overspeed [min’']

o0 x Number of Ignition Qutputs

Ignition Frequency =

4-stroke engine:

1 Overspeed [min]

Ignition Frequency = Ex 5% x Number of Ignition Outputs
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Electrical Data for Inputs and Outputs
The inputs and outputs of the ignition controller have the following electrical data:

Inputs and outputs Values

Analog current input Current range: o mA to 20 mA (adjustable in MICT)
Input impedance: 27 Q || 1 pF

Analog voltage input Voltage range: o mA to 10 mA (adjustable in MICT)
(optional) Input impedance: 12.4 kQ || 200 nF

Auxiliary analog input 5 Vto 24V /50 mA depending on the configuration in the
supply voltage MICT

Binary input (Start/Stop) Wiring

Input current: max. 20 mA
Ignition stop: o Vto 1V (low level)
Ignition release: 4.5V to 32 V (high level)

Binary input (schedule A/B)  Wiring

Input current: max. 20 mA
Schedule A: o Vto 1V (low level)
Schedule B: 4.5 V to 32 V (high level)

Binary input (GPI, general Wiring

purpose input) Input current: max. 20 mA

Low level: o Vto1V
High level: 4.5 Vto 32V

(Function dependent on the configuration in MICT, see
Inputs/Outputs — Inputs on page 112)

Go/NoGo and GPO outputs  Three GPO (General Purpose Outputs) and one Go/NoGo
output

Implementation as optical MOSFET relay
Maximum switching voltage: 32 V DC
Peak/steady current: max. 100 mA DC

Output power: max. 2.5 W

Internal resistance: 58 Q to 63 Q

Activation delay: 0.5 ms / max. 100 mA load
Deactivation delay: 0.2 ms / max. 100 mA load

If a short is found at the output, a safety circuit, which makes
the output highly resistive, is found at the output, so that the
current sets itself at 50 mA to 60 mA.
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Inputs and outputs Values
Signal LED Eleven LEDs are used as status indicators.
ASO outputs Two auxiliary synchronization outputs

TTL level (5 V)
max. current: £ 10 mA

Pickup input Impedance: 10 kQ

The voltage supply for active pickup can be set using the
MICT from 5 Vto 24 V.

Max. frequency for the pickups: 15 kHz

The formula for determining the frequency of the pickups can
be found in the note following this table.

For a pickup output impedance of 120 Q to 10 kQ, the pickups
connected to the MIC6 may not have a higher voltage than
+40 V and the connected power may not exceed 1 W.

Ignition coil outputs Output voltage: max. 250 V

Output energy in normal operation: max. 600 mJ (depending
on the ignition coils used)

Output energy in the start phase (boost): max. 700 mj

Frequency of the pickups

The frequency of the pickup is calculated as per the following formula.

Overspeed [min™")
60

Frequency = x Number of Pickup Events per Revolution

Rev. 09/2019
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I 4 Product Description

4.1.6 Interfaces
Depending on the device version, the following interfaces are available:

USB Interface
- Compatible with USB 2.0

- The Connector B version is only suitable for temporary data exchange and not for a
permanent connection.

- Max. wire length 5 m (16.4")

CAN Bus Interface
— Classical Extended Frame Format (CAN 2.0B)

- AsperlSO 11898 standard, 50 kbit/s to 1 Mbit/s
- Transient-proof (automotive classification)
- Max. 110 participants

- Max. wire length 250 m (820'") depending on the transfer rate

RS485 Interface
- According to TIA-485-A (03/2003)

- Max. 32 participants
- Max. data transfer rate 9.6 kbit/s to 115.2 kbit/s

- Max. wire length 100 m (328') depending on the transfer rate

Pay attention to the wiring diagrams

Depending on the device version, certain signals or interfaces described in
these instructions may not be available. You are also always to pay
attention to the wiring diagrams enclosed with the input and output cable
harnesses.

4.1.7 Requirements for External Equipment
External equipment shall fulfill the input and output specifications of the MIC6.
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4.1.8 Overview Drawings
The drawings shown correspond to the standard version of the MIC6-Marine with service screw
and installed vibration dampers.

Plan View
224 mm (8.82")

fany f==i ==

<& Ik +
< e

00000000
000

348 mm (13.70")
200 mm (7.87")
391 mm (15.39")

74 mm (2.91")
e®

27.8 mm
(1.09

T J L-J T 17

240 mm (9.45")
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I 4 Product Description

Front View

114 mm (4.50°)

161 mm (6.30")

311 mm (12.20")

Service Screw
Below the service screw are a USB port and a button.

UsB PB

By ©

o

Labeling Function

usB USB connection for connecting to the computer

PB Button acknowledges errors, warnings and alarms or triggers a reset of
the ignition controller. Please refer also to the notice below.

Behavior of the button PB
With the PB button on the device you can perform the following actions:

— Press briefly (< 3 5):
Existing warnings are acknowledged.

— Presslongerthan3s:
If no pickup signals are detected and an operational error exists, this
will be acknowledged together with all alarms. Warnings are
acknowledged in any case, even if no operational error exists.

— Press longer than 15 s:
If no pickup signals are detected, the ignition controller restarts.
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4.1.9 LED Functions

LED functions

Status

Firing

Status
Firing
Pickup 1/4
Pickup 2/5
Pickup 3/6
GPO 1
GPO 2
GPO 3

Up to firmware version 1.1.00000:

LED flashes green if the device is running with no errors.
The LED flashes red if an error has occurred.
The LED flashes yellow if a warning has occurred.

From firmware version 1.1.00000:

LED flashes green if the device is running with no errors.
The LED flashes red if an error has occurred.
For details, refer to the following overview.

The firmware version of your device can be found in the MICT in the
window Runtime Data — Information. Refer to the section Runtime
Data — Information on page 144.

LED lights up when the ignition is active (exception: during the self
test).

Pickup 1to 6 Flashing LEDs indicate activity of the pickups.

GPO1to3

Rev. 09/2019

LED is on when the particular GPO is activated.

£ MOTORTECH
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I 4 Product Description

Indication via the Status LED (from firmware version 1.1.00000)

The flashing sequences shown below are repeated until the device has left the respective state
again. However, the flashing sequences are always executed to the end and are not interrupted
accordingly.

The status LED flashes green:

- Waiting for sufficient supply voltage
Fast flashing green/off 100 ms

- Synchronization/ Firing active
Flashing one time green 250 ms on, 750 ms off

- Ready for operation
slow flashing green/off 500 ms

- Bootloader - connection to computer started/ Update mode
Flashing one time green 2,000 ms on, 250 ms off

- Firing locked
3 flashes green/off 250 ms, 750 ms off

- Configuration/Wait for o RPM
6 flashes green/off 250 ms, 750 ms off
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The status LED flashes red:

Critical error/ Assertion
fast flashing red/off 100 ms

Operating error - General/ System error
slow flashing red/off 500 ms

Bootloader - Faulty firmware
Flashing one time red 2,000 ms on, 250 ms off

Operational error - Pickup
2 flashes red/off 250 ms, 750 ms off

Operational error - Overspeed
4 flashes red/off 250 ms, 750 ms off

Operational error - Insufficient supply voltage
5 flashes red/off 250 ms, 750 ms off

The status LED flashes orange:

Self test
Flashing one time orange 250 ms on, 750 ms off

Rev. 09/2019
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I 5 Installation Instructions

5.1 Unpacking

Unpack the equipment, taking care not to damage it, and ensure that the operating manual is
always stored with the ignition controller and is easily accessible. Always place the device safely
and protected from falling over or falling down as long as it is not fastened to the selected
installation location as specified (see Installation of the Ignition Controller on page 33). Check
the contents for completeness and verify that the device type meets your application
requirements.

Scope of Supply
The scope of supply of the MIC6 ignition controller consists of the following components:

— Ignition controller of the MIC6 series
- Accessory kit for installation incl. four vibration dampers
— Ground strap

- Storage device (USB flash drive or CD-ROM) with software for configuring the ignition
controller

- USB interface cable for connecting the ignition controller to a computer

- Operating manual
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5.2 Installation of the Ignition Controller

The installation of the MIC6 ignition controller is generally implemented on a fixed bracket e. g.
on a wall near the engine. Use the included vibration dampers and the ground strap. The
following vibration dampers are included in the scope of supply of the respective devices:

- MIC6: rubber vibration dampers

- MICé6-Marine: wire rope vibration dampers

The installation location of the controller must be selected so that the distance to the pickups
installed on the engine ensures a reliable signal transmission to the ignition controller, and so
that there is adequate space for maintenance and repair work. The mechanical specifications
must always be complied with (refer to Mechanical Data on page 20). The ground strap serves to
ground the ignition controller and must be used accordingly. Ensure a flawless electrical
connection for this purpose.

To ensure sufficient cooling through the cooling body, the device must be mounted so that the
vanes of the cooling body are vertical and the hot air can escape upwards unimpeded.

Risk of destruction!

The devices of the MIC6-Marine series may only be installed directly on the
engine with the supplied wire rope vibration dampers. Furthermore the
permissible vibrations and temperatures must not be exceeded because
otherwise electronic components can be destroyed. Refer to the section
Mechanical Data on page 20.

The MIC6 series devices intended for use with stationary gas engines may
only be installed on the engine if the wire rope vibration dampers intended
for the marine devices are used (not included).
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5.2.1 Installation of the Vibration Dampers

The MIC6-Marine series is supplied with wire rope vibration dampers, which must be used to
maintain the permissible vibration conditions. For the MIC6 series devices used for stationary
gas engines, the rubber vibration dampers supplied must be used.

MIC6-Marine

Note that the wire rope vibration
dampers have a hole on one side and
a thread on the other. The side with
the hole is used for the installation
on the device.

1. Fasten the four vibration
dampers Bl to the MIC6. For this
purpose, use four screws
M8x30 , eight washers M8
and four lock nuts Mg .

ﬁ r3 27 Nm /19 Ib-ft

2. Fasten the MIC6 to the selected
installation location using the
vibration dampers. To do this,
use four screws M8x20 EEll and
four rim lock washers Mg L.

3. Turn the screws into the thread
of the wire damper with the
specified torque.

» Fasten the ground strap to
the ground pin (see
Installation of the Ground

w Strap on page 36).

Bl 27 Nm /19 Ib-ft

34 Rev. 09/2019



I 5 Installation Instructions

MICé

£ MOTORTECH

There are two options for using the vibration dampers from the MIC6's scope of supply. The hole
patterns can be found in section Overview Drawings on page 27.

Option A

!e!___-_

b

1

o E=—

H =

3 27 Nm / 19 Ib-ft Q

Option B

PR 27 Nm /19 Ib-ft

=
5 P YRE: R e,
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Fasten the four vibration dampers Bl to the selected
installation location. Use four screws M8x16 , four
rim lock washers M8 Bl and four washers ms .

Fasten the MIC6 to the vibration dampers. Use four
washers M8 I and four lock nuts M8 B

» Fasten the ground strap to the ground pin (see
Installation of the Ground Strap on page 36).

Fasten the four vibration dampers Hl to the MIC6. Use
four screws M8x16 , four rim lock washers M8
and four washers M8 L.

Fasten the MIC6 to the selected installation location
using the vibration dampers. Use four washers M8
and four lock nuts M8 EA.

> Fasten the ground strap to the ground pin (see
Installation of the Ground Strap on page 36).
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5.2.2 Installation of the Ground Strap

—_— 1. Fasten the ground strap Bl to the MIC6 ground
K pin. To do so, use one washer M6 B, one tooth

T lock washer A6 Bl and one poly lock nut M6 4 ]

2. Connect the ground strap to one of the sides
suitable for grounding.

N

% 11 Nm /8 Ib-ft | > You can wire the ignition controller as
. 3 gsspc;g)eeg;n section Wiring of the Device
= g

il

5.3 Determine the Installation Location of the Pickup
Set the positions of the pickups depending on engine type and application. All angle reference
information is based on:

TDC 1st cylinder / compression cycle

The installation location for the pickups must have adequate mechanical strength and must not
exceed the specified temperature ranges. The pickups are designed for the appropriate use
only, multiple use of the pickup signal is not permissible. Ensure good accessibility to facilitate
the calibration of the sensor. Comply with the pertinent regulations for the wire routing.

For the exact positioning of the individual pickups, refer to the examples given in the drawings
(see section Input Wiring — Pickups on page 42).
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1

6.1 Input and Output Wiring on the Controller

Operational safety!

All connector screws and screw joints must be adequately tightened. Refer
to the section Mechanical Data on page 20.

Assignment of the wire colors

Take the assignment of the wire colors of the wiring harness for the input
and output wiring from the wiring diagram enclosed with the wiring
harness.

Pay attention to the wiring diagrams

Depending on the device version, certain signals or interfaces described in
these instructions may not be available. You are also always to pay
attention to the wiring diagrams enclosed with the input and output cable
harnesses.

6.1.1 Input Wiring
The following section shows the input wiring of two device versions. Other variants of the device
can have different connectors and pin assignments:

— Standard device version with six pickup inputs (35-pole and 26-pole input connectors)

— Device version with three pickup inputs (35-pole input connector)

Assignment of the Connections

The tables contains the pin assignment of the standard version of the MIC6. The device version

with three pickup inputs has only one 35-pole input connector.

Rev. 09/2019

£ MOTORTECH

37



I 6 Wiring of the Device

35-Pole Input Connector

First input connector (35-pole, outside view)

Pin

~ I oo M m 9o N @ >

c 4 »w ® vV =z =z =

38

Assignment

L+(24V)

L — (negative pole)

Pickup 1 Power
Signal
GND
Shield

Pickup 2 Power
Signal
GND
Shield

CAN 1 Hi
Com
Lo
Shield

Go/NoGo +

Go/NoGo -

GPO1 +

GPO1 -

Pin

\'
w
X
Y
YA

o o o

-

S ua

Assignment

ASO1 +

ASO Com

Pickup 3 Power
Signal
GND
Shield

GPO2 +

GPO2 -

Analog GND

Analog Power

Timing I in —

Timing lin+

Analog Shield

Start/Stop +

Schedule A/B +

GPI +

Binary Com
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26-Pole Input Connector

Second input connector (26-pole, outside view)

Pin Assignment Pin Assignment

A RS485 Shield R RS485 X+

B Com S X -

C Pickup 4 Power T RX +
D Signal U RX -

E GND Vv ASO2 +

F Shield w ASO Com

G Pickup 5 Power X Pickup 6 Power
H Signal Y Signal
J GND z GND

K Shield a Shield
L CAN 2 Hi b GPO3 +

M Com C GPO3 -

N Lo

P Shield
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6.1.2 Input Wiring — Power Supply

Operational safety!

The proper functioning of the device is only guaranteed if the device is
operated within the permissible supply voltage range. Therefore, use a
power supply in accordance with the specifications in the operating

manual.

i Design of power supply
For the power supply, an overcurrent protection mechanism must be set up
with a circuit breaker (20 A DC with tripping characteristic B), which allows

switching off. When selecting the circuit breaker, the conditions of the
installation site and the ambient temperature must be considered. The
circuit breaker must be easy for the user to access and marked as a
disconnecting device for the ignition controller.

NOTICE

If the power is supplied via a power supply unit, the following specifications
must be observed additionally:

— Voltage: 24 V DC; Current: at least 30 A

—  Wiring: at least 2.5 mm2 cross-section
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35-Pole Input Connector
L 2 24V DC (nominal voltage)

Variations
1 Battery Generator Control unit
2 Power supply
—o L+
o |L- o + —o
s
e 3 Battery Charger
L+ L-
= f—-o0
~v
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6.1.3 Input Wiring — Pickups

Example Configuration
(Two Pickup Sets each with one Active, two Passive Pickups)

Pickup Set 1 (35-Pole Input Connector)

~~ Camshaft

Crankshaft
(Reset)

\ /

Crankshaft

Signal @

Shield
Shield
Shield

Pickup 1 Pickup 2 Pickup 3
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Pickup Set 2 (26-Pole Input Connector)

~ Camshaft

Crankshaft
(Reset)

\/

Crankshaft

®

o
=
[0

©

T ©
£ 5
o w

(9]
©),
GND (m)

Shield
-Power @
Signal @
ano (©)

Shield
_Power @
Signal @

Shield

Pickup 4 Pickup 5 Pickup &

The recommended distance to the triggering is 0.75 mm to 1 mm (0.03" to 0.04") for MOTORTECH
pickups. Please note that additional fine-tuning is required for every pickup position due to the
different conditions of the engines.

One revolution of the pickup changes the distance as follows:

Thread Change in distance

M12x1 1 revolution 2 1 mm (0.04")
5/8"-18 UNF 1 revolution 2 1.41 mm (0.05")
3/4"-16 UNF 1 revolution 2 1.59 mm (0.06")
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Allocation of the Wire Colors (Example Configuration)

Camshaft

PIN Designation

C Pickup 1/4 Power
D Pickup 1/4 Signal
E Pickup 1/4 GND

F Pickup 1/4 Shield
Crankshaft (Reset)

PIN Designation

H Pickup 2/5 Signal
J Pickup 2/5 GND
K Pickup 2/5 Shield
Crankshaft

PIN Designation

Y Pickup 3/6 Signal
V4 Pickup 3/6 GND

a Pickup 3/6 Shield

Wire color
Brown
black

blue
Shield

Wire color
Flywheel with pin
White

Flywheel with pin
Brown

Shield

Wire color
White
Brown
Shield

Flywheel with hole
Brown
Flywheel with hole
White

For problems with the pickup signals, refer to the section Pickup Input Errors on page 167.

page 98.

44

Adjusting the pickup sensitivity

Depending on the type of impulse source (interference), it may be necessary
to increase the pickup sensitivity to ensure that the resultant signal
strength is sufficient for reliable operation. You can make these
adjustments in the MICT. Refer to the section Engine — Pickups — General on
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NOTICE

Aux. pickup supply voltage

An auxiliary supply voltage for active pickups can be configured using the
MICT. The voltage can be set in the range from 5 V to 24 V and is supplied at
the connections Pickup 1 Power to Pickup 6 Power. Refer to the section
Engine — Pickups — General on page 98.

6.1.4 Input Wiring — Timing and Safety Devices

Example Configuration

35-Pole Input Connector

*) See subsequent drawings for details

+) x = bridge for permanent authorization

(must be removed for external ignition

authorization)

Analog GND @
Analog Power @

Timing lin — @
Timing | in + @

—0"/0—1
Switch Start/Stop

open Ignition — OFF
I 1
I closed Ignition — ON
Switch A/B
@ open Schedule A
RS-
5 2 2 5 c:; closed Schedule B
g5 3 E
2 ? 5
w

Rev. 09/2019
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Two-Wire Transmitter

46

Analog Power

l Timing l'in +

NOTICE

Timing lin -

Analog GND
Analog Shield

Four-Wire Transmitter

A

+V

+1

Analog Power

Timing | in +

Auxiliary analog input supply voltage

\ , Timing lin -
Analog Shield

An auxiliary supply voltage for the analog inputs can be configured using
the MICT. The voltage can be set in the range of 5 to 24 V and is made
available on the connection Analog Power. Refer to the section Timing —

Analog Inputs on page 103.
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I 6 Wiring of the Device = MOTORTECH

Wiring MIC6 ignition controller and DetCon detonation control system

The following diagram shows an example of the wiring of a MIC6 ignition
controller with a DetCon detonation control system in cases where the

—_— analog current signal (4-20 mA) at the output / out is to be used for the
EXAMPLE s Al q
ignition timing adjustment.

MICé6-
ignition
controller

(=) Analog GND
o Analog Power
e Timing | in -
(<) Timing Iin +

+  control system
o | -~

| out + 6
| out - O

Power in
5V DC O

DetCon
O O Ol detonation
§

Com

Uout+ O
O

O

Trip O

O

Com O

Engine
Knocking

Load
Reduction

Furthermore, the limits of the analog current input will need to be set at
4 mA to 20 mA and the auxiliary supply voltage of the analog inputs to 24 V
in the MICT. Refer to the section Timing — Analog Inputs on page 103.

The timing is transmitted by MIC6 via the auxiliary synchronization output
(ASO) to the DetCon, and will need to be wired and configured accordingly.
Refer to the section Output Wiring — Binary Outputs (Go/NoGo, GPO, ASO)

on page 48.
@ General purpose input GPI
The general purpose input GPI can be assigned various functions via the
configuration. Refer to the section Inputs/Outputs — Inputs on page 112.

NOTICE
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6.1.5 Qutput Wiring — Binary Outputs (Go/NoGo, GPO, ASO)

Example Configuration
oL+

T Ca
Ca e

*) DetCon or other
external device (for
wiring of the DetCon,
see following example)

oL- Ki=Go/NoGo relay

K2/K3/K4 = GPO relay
w L2 24VDC
R\DO

[«

EOEOLOL® | ® W ®
+ 1 + 1 + t= = + 1 k=3 + E + |
o o — — — [=3 @ o o 2 o o ) fae)
(G} (&} o o o (&) = o o = o (&) o o
g 2 o o w o (] o o w (2] o o o
= Z O 0 I« 5 [O N O] < 5 O O
8 8 < <
L | | |

35-Pole Input Connector 26-Pole Input Connector

Binary output as low-side switch Binary output as high-side switch
L+ o | +
IOuH
Al | Out-
5 L | "
2 |
_L] Relay
o Qut + A2
TOui—
L— ol —

(L224VDQO
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I 6 Wiring of the Device = MOTORTECH

DetCon connection

Connect one of the two ASO outputs on the DetCon to the connections in A
and in B on connector Synchronization.

EXAMPLE
DetCon

Synchronization

<<
=

inB

Shield

asot+ (<)
=

ASO Com

6.1.6 Wiring — PowerView3

Connect the PowerViews3 visualization unit to the MIC6 as follows.

CAN Connection between Ignition Controller and PowerViews

As shown in the following illustration, you can connect the PowerViews3 directly to the
MOTORTECH ignition controller using the CAN cable delivered with the PowerViews. To do so,
you need to insert the connector in the CAN interface on the PowerViews. On the ignition
controller, connect the color-coded conductors of the CAN cable to the correct CAN interface
connections.
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I 6 Wiring of the Device

You can use both CAN interfaces (CAN1 or CAN2) on the device. In the example you see the wiring
via CAN1.

Shield

Connector for CAN

E_ ] interface on PowerViews
b

Term
Lo
Hi
Term
Com

green
brown

N\ white

caNH (5
ANCom ()
cANLe ()
CAN Shield ()

CAN interface on the
1200 ignition controller

I

PowerViews Power Supply via the Ignition Controller

If you use a MOTORTECH ignition controller with a service cover and connector strip, you have
the option of supplying power to the PowerViews via the ignition controller. A special connector
isincluded in the PowerView3's scope of supply. The connector for the voltage supply of the
ignition controller must be replaced by this one.

Connector supplied with Connector supplied with
the ignition controller: PowerViews:

Proceed as follows:
1. Disconnect the power supply to the ignition controller and, if necessary, to the PowerViews.

2. Remove the connector for the power supply from the ignition controller.
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I 6 Wiring of the Device

S MOTORTECH

Negative terminal: Disconnect the conductor from the contact Bl and insert it into contact B
of the connector provided with the PowerViews.

Positive terminal: Disconnect the conductor from the contact B8 and insert it into contact B}
of the connector provided with the PowerViews.

From the PowerViews power supply cable, plug the L— wire (white) into contact B ror
plugging into the contact, use a wire end ferrule provided with the PowerViews.

From the PowerViews power supply cable, plug the L+ wire (brown) into contact B ror
plugging into the contact, use a wire end ferrule provided with the PowerViews.

Insert the connector provided with the PowerViews into the power supply connection of the
ignition controller.

Insert the connector at the other end of the PowerView3s power supply cable into the
PowerViews power supply connection.

Connect the device's power supply.

» The power supply of the PowerViews is now provided through the connector on the
ignition controller.

6.1.7 Output Wiring — CAN Bus Interface
The product must be connected to a CAN bus as follows:

First device Second-to-last device
€ E 3z £ E =z
£38 3 £ 3 3
CAN 1 CAN 2
5 E = s E = - // _
]Q:‘ & % 8 & R=120 Q \\ R=120 Q

0J0) W®E
T 5§33 £ E 3 2 5 E B & 5 8
D R T — o o~ = T o - o
E - = u E N = W
S 23z © %3¢z
(&) =< (&) <C
1 O 9,
35-pole 26-pole Second device Last device
input connector input connector
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52

CANopen® protocol

If you require information on the CANopen® protocol, contact your
MOTORTECH contact person.

CAN Bus wiring

Note the following when connecting the CAN bus:

— Each bus end must be fitted with a terminating resistor of 120 Q (see

drawing).

— The maximum wire length depends on the bit rate:

Bit rate

1 Mbit/s
800 kbit/s
500 kbit/s
250 kbit/s
125 kbit/s
50 kbit/s

Maximum wire  Maximum length

length of a stub
25 m (82') 1.5m (5"
50 m (164") 2.5m (8"

100 m (328") 5.5 m (18"
250 m (820") 11m (36')
500 m (1,640") 22 m(72")

1,000 m (3,280") 55 m (180"

Maximum length of
all stubs

7.5 m (25"
12.5m (41")
27.5m (90"
55 m (180")
110 m (360")

275 m (902")

— Only use cables that are specified by the manufacturer for use in the

CAN bus.
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6.1.8 Output Wiring — RS485 Interface
The RS48s5 interface can be wired as two-wire or four-wire wiring and twisted cables must be
used. With both variants the load resistance (Rr=120 Q) is the characteristic impedance of the

cable.

Two-Wire Wiring

First device

RX +
RX -

TX-
TX +

Four-Wire Wiring

First device
(Master)

RX +

RX -
TX-

TX+

Rev. 09/2019
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Last device
RX +
RX -
iR AN ]
TX -
TX +
Second device Second-to-last device
Last device
(Slave)
/A X+
i ( i
TX -
NN e
: )) 2
7 / RX +
+ 1 1 - + 1 1 +
B EE K 5 BE E

Second device
(Slave)

Second-to-last device
(Slave)
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Connection on the Ignition Controller

54

shield (>-)

RS485

g + 1 + 1
8 & & &2 B
EEROO
£ + I + 1

v o
2328 3 5
r o© © o© o

NOTICE

Wiring of the RS485 interface

Follow these instructions for the RS485 interface wiring:

Max. 32 devices can be connected to a bus.

The maximum wire length is 100 m (328') depending on the transfer
rate.

Each bus end must be fitted with a terminating resistor with 120 Q in
each pair of leads (as indicated in the drawing).
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6.2 Ignition Coil Wiring

Ignition coil wiring

In the MICT there are two types of wiring with predefined output
configuration supported in the engine database for many engines:

— Wired in straight order

— Wired in firing order

For information on straight order wiring refer to Straight Order Wiring of the
Ignition Outputs on page 58 and Engine — Parameters on page 89.

For wiring in firing order, the first cylinder in the firing order is connected to
the A1 output, the second to B1 (A2 for one output board), etc.

If a different wiring was implemented, the output configuration in the MICT
must be adapted accordingly. Please note that the wiring cannot be
checked by the software (see section Engine — Parameters on page 89).

® Conductor cross-section for primary wiring
If you do not use a harness manufactured by MOTORTECH, the primary
wiring must have a conductor cross-section of 1.5 mma2.

NOTICE
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6.2.1 Ignition Coil Wiring for a 35-Pole Connector
The table shows the pole assignments for the output connector.

Bo oA
oCofofoloC
oNoMol oKoJ oH
oWoVoloTl oSoRoP)
octoboa0ZOYOX
ohogof oeod
Okommm

35-pole output connector (outside view)

Pole

A
B
C
D
E
F
G
H

3 =" =

56

Output

Output A1
Output B1
Output A2
Output B2
Output A3
Output B3
Output A4
Output B4
Output Ag
Output Bg
Output A6
Output B6

Ground

Pole

N
P
R
S
T
U
\'
W
X
Y
z

Q

Output
Output A7
Output B7
Output A8
Output B8
Output Ag
Output Bg
Output A10
Output B1o
Output A11
Output B11
Output A12
Output B12
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6.2.2 Ignition Coil Wiring for 17- and 14-Pole Connectors
The table shows the pole assignments for the output connector.

17- and 14-pole output connectors (outside view)

Pole Output (17-pole) Pole Output (14-pole)
A Output A1 A Output B1
B Output A2 B Output B2
C Output A3 C Output B3
D Output A4 D Output B4
E Output As E Output Bs
F Output A6 F Output B6
G Output A7 G Output B7
H Output A8 H Output B8
J Output Ag | Output Bg
K Output A10 J Output B1o
L Output A11 K Output B11
M Output A12 L Output B12
N Ground N Ground
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6.2.3 Straight Order Wiring of the Ignition Outputs

Risk of damage to engine

If you use MOTORTECH wiring rails for straight order wiring, it is absolutely
necessary that they are correctly selected and installed for the respective
engine. Even a rotated installation can cause serious damage to the engine,
for example.

Straight order wiring, along with wiring in firing order, is supported by the MICT for many
engines with predefined output configurations in the engine database. That means that if the
wiring is carried out accordingly and the option Wired in Straight Order is selected in the MICT,
no other adaptation of the output configuration is necessary.

You can use straight order wiring, if:

— Wiring takes place via a corresponding MOTORTECH wiring harness and a MOTORTECH
wiring rail. The harness is marked with the following information: PLEASE NOTE! The firing
order needs to be configured directly in the ignition controller. The ignition coils on the
wiring rail are identified with Connector Pin 1 to Connector Pin X.

- Make the wiring of the ignition controller corresponding to the instructions in the following
sections (for example with an open wiring harness or via a junction box).

Execution of straight order wiring is dependent on the following factors:

— One or two output banks in the ignition controller

- Thetype of engine (in-line or V-engine)

- Alignment of the wiring rail(s)
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6.2.4 Straight Order Wiring of the Ignition Outputs — Overview

The table contains the allocation of the MIC6 outputs to the cylinders.

Output In-line engine V-engine

Connector* Connector*  Coil**
Output A1 1 1 1 1
Output B1 1 2 2 1
Output A2 1 3 1 2
Output B2 1 4 2 2
Output A3 1 5 1 3
Output B3 1 6 2 3
Output A4 1 7 1 4
Output B4 1 8 2 4
Output Ag 1 9 1 5
Output Bg 1 10 2 5
Output A6 1 11 1 6
Output B6 1 12 2 6
Output A7 1 13 1 7
Output B7 1 14 2 7
Output A8 1 15 1 8
Output B8 1 16 2 8
Output Ag 1 17 1 9
Output Bg 1 18 2 9
Output A10 1 19 1 10
Output B1o 1 20 2 10
Output A11 1 21 1 11
Output B11 1 22 2 11
Output A12 1 23 1 12
Output B12 1 24 2 12
Ground

Connector* = connector on the wiring rail
Coil** = ignition coil with the corresponding number on the wiring rail
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The ignition controllers of the MIC6 series include freely configurable safety and auxiliary
functions that, amongst others, can shut down the engine in case of fault.

Angle indications in the operating manual

All angles in this operating manual are given in °crankshaft. Exceptions are
clearly identified.

7.1 Redundant Pickup System

With MIC6 series ignition controllers you can use two redundant pickup sets, each having up to
three pickups. If the two pickup sets are available, both sets are evaluated by the ignition
controller.

If one pickup of a set fails, the other set takes over the entire functionality. The pickup set that is
affected by the failure is ignored. If in both sets at least one pickup fails, the ignition controller
switches into error mode.

If you want to use a redundant pickup system, you should note the following points:
- In both pickup sets, use identical pickups for corresponding signals (Cam, Reset, Trigger).
- Using a trigger disc with many teeth (e.g. N=160) improves the accuracy of the system.

— Run tests on the pickup system you have set up for your individual application.

The redundant pickup system is set up in the MICT. For additional information read the sections
Engine - Pickups — General on page 98 and Engine — Pickups — Inputs on page 100.

7.2 Pickup Sensitivity

To increase the signal interference distance, the sensitivity of the pickup signal inputs can be
changed for suitable pickup signals. This setting can be implemented individually for each
input. For this purpose, a pre-trigger voltage can be set below which signals are interpreted as
interference and are therefore not analyzed. A pre-trigger voltage set to a high level will thus
result in a low pickup sensitivity level.

You can enter the settings for the pickup sensitivity with the MICT. For passive pickups, you can
set the pre-trigger voltage so that it depends on the speed. Refer to the section Engine — Pickups
— General on page 98.

7.3 Monitoring of Pickup Signals

The MIC6 monitors the pickup signals. Any other errors are displayed in the MICT. For more
information on the errors, please refer to the overview in the section entitled Pickup Input Errors
on page 167.
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7.4 Go/NoGo

The binary output (Go/NoGo) is a potential-free output. It is closed during firing and opens when
the ignition switches off. The max. switching current is 100 mA. The output can drive an external
relay that e.g. opens a gas valve.

The following errors can cause the ignition outputs to shut down:
— Overspeed

—  Pickup error

—  Error HV power supply

— Failure of the output monitoring

- Overload/temperature shut-down

- Alarms

- Insufficient supply voltage (Low Power)

Use master control

The outputs of the MIC6 are not SIL compliant. Therefore, always use an
additional master control for safety-critical applications.

7.5 lIgnition Timing Adjustment
The ignition controller has several functions for the timing correction.

® Influences on ignition timing
Be aware that the actual timing of the engine can also be influenced by
external signals (e.g., analog current or voltage input).

NOTICE

Operational safety!

The MIC6 ignition controller must first be correctly configured for the engine
being used before you can start the engine.

An incorrect configuration can result in damage to the engine.
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The figure below gives you an overview of the different functions of the timing correction, which
will be explained in more detail in the subsequent sections. Functions that can be
activated/disabled via the MICT are marked by a switch symbol. Depending on the device
version, some functions might not be available.

62

Per schedule:

|Base Timing

| Speed Curve

— —®

| Analog Voltage Input

——

| Analog Current Input

—

Global:

| Ignition Timing Correction

Per cylinder:

Cylinder Individual
Offset

Limited by the
min./max. cylinder
individual offset

Timing

Limited by the min./max.
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7.5.1 Analog Inputs

The timing point control can be adjusted with a linear current signal. This signal can be
supplied, for example, by a potentiometer, a pressure sensor for charging pressure, or a
detonation controller.

With the analog process signal (current loop signal) at the analog current input, the timing point
can be offset in the advanced or retarded direction within a defined range.

Similarly or additionally, the timing can also be influenced by an analog voltage signal at the
corresponding input.

The levels of the analog inputs can be set in the range from o mA to 20 mA and o V to 10 V. You
can make this configuration with the MICT. Refer to the section Timing — Analog Inputs on
page 103.

At the voltage output (Analog Power), a configurable auxiliary voltage is supplied that can be
used for supplying power to external sensors.
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EXAMPLE

Configuration examples

In this example the analog inputs are configured in the Timing — Analog

Inputs window as follows:
— Input current: 4-20 mA
— Input voltage: o-5 V

Characteristic 4-20 mA / 0-5 V - Ignition timing adjustment toward
retarded.

BTDC
A

400 4mA oV

30° — s g
Base Timing 30° BTDC
15° retarded ignition

15° I8

20mA 5V
50
o° =y

Characteristic 4-20 mA / 0-5 V - Ignition timing adjustment toward
advanced.

BTDC
A

40° T~ 20mA 5V

30° 15° advanced ignition

159 Base Timing 15° BTDC
4mA oV

SD

o° <

7.5.2 Cylinder-to-Cylinder Alignment
The cylinder-to-cylinder alignment enables the user to change the timing for individual cylinders
to optimize their combustion.

You can enter the settings for the cylinder-to-cylinder alignment with the MICT. Please refer to
the chapter Cylinder Individual Offsets on page 152.
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® Use of measuring unit
Use this setup option only if a suitable measuring unit is available for
determining the optimum timing point, so that the result of a change can be

NOTIICE assessed immediately.

7.5.3 Speed Curve

To optimize the ignition, for example, during the start phase of the engine, a speed curve can be
defined for the MIC6 ignition controllers. To create this curve, up to eight adjustable speed
points are available.

You can configure the speed curve with the MICT. Refer to the section Timing — Schedule A/B -
General on page 104.

7.5.4 Ignition Timing Correction

Via the ignition timing correction, the global ignition timing, limited by the timing limits of the
current schedule, can be adjusted. Refer to the section Runtime Adjustments — Timing on page
148.

7.6 Firing Angles
The min. distance between two ignition angles depends on the overspeed. The smallest ignition
spacing per output bank can be calculated using the following formula:

Overspeed [min]

0 x 360° x 2.8 ms

Ignition Angle =

7.7 HV-Power Supply Error Monitoring
The voltage applied is monitored for excess voltage or low voltage by the integrated power
supply. For both errors a Power-Fail error is saved and the device shuts off.

7.8 Output Monitoring

Electronic switches are used for the ignition outputs of the MIC6 ignition controller If one of
these switches is defective, this would lead to a primary short or a primary open output. This can
cause problems when operating the engine or can damage the engine. The function of the
outputs is therefore monitored and errors that occur are displayed in the runtime data in the
MICT or can be transmitted via field buses. Different alarms are available for monitoring the
misfire rate. It can also be defined that the ignition is switched off in the event of output errors.
Refer to the section Inputs/Outputs — Alarms on page 108.
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7.9 Schedules A/B
The MIC6 ignition controllers offer two separate schedules for the parameterization of the
ignition timing and energy.

By closing input Schedule A/B, the listed parameter settings for schedule B can be selected. A
possible application for this is e.g. operation with different gases. If only one schedule is
configured, this is used regardless of the switch position.

You can configure the schedules with the MICT. Refer to Timing — Schedule A/B - General on
page 104 and Timing — Schedule A/B — Energy on page 106.

Operational safety!

If you use schedules A and B, the advanced timing point should be linked to
schedule B (switch closure). If a wire ruptures, schedule A is automatically
selected with the retarded (and thus safer) timing point.

7.10 Alarms

The MIC6 ignition controllers include 16 freely configurable alarms in total. These alarms can be
freely allocated to the three general purpose outputs (GPO1 to 3) and set depending on the
following functions:

- Limit for speed exceeded/not reached

- Limit for engine operating hours exceeded/not reached

- Limit for spark plug operating hours exceeded/not reached
— Warning active

- Error active

- Limit for temperature exceeded/not reached

- Limit for supply voltage exceeded/not reached

- Limit for global ignition timing exceeded/not reached

- Limit on the analog voltage input exceeded/not reached

- Limit on the analog current input exceeded/not reached

- Limit of the minimum spark duration exceeded/not reached
- Misfire rate (primary, single output) over limit

- Misfire rate (primary, all outputs) over limit

- Misfires per second (primary, all outputs) above threshold
- Consecutive misfires (primary, single output) above threshold

- Misfire rate (secondary, individual output) above threshold
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- Misfire rate (secondary, all outputs) above threshold
- Misfires per second (secondary, all outputs) above threshold

- Consecutive misfires (secondary, single output) above threshold

A hysteresis can be defined for some alarms. You can configure the alarms with the MICT. Refer
to the section Inputs/Outputs — Alarms on page 108.

7.11 GPO: General Purpose Outputs

The general purpose outputs (GPO1 to GPO3), can freely be configured as normally open or
normally closed. The GPOs can be used for the freely definable alarms. Several GPOs can be
assigned to one alarm and, conversely, several alarms can be assigned to one GPO.

You can enter the settings for the alarms with the MICT. Refer to the section Inputs/Outputs —
Alarms on page 108.

7.12 ASO: Auxiliary Synchronization Outputs

The auxiliary synchronization outputs ASO1 and ASO2 provide the synchronization between the
MIC6 ignition controller and connected control units. The possible applications include
detonation control, valve control, and fuel injection control.

The ASO signal is low-active, i.e. the pulse width is defined as the time difference between the
raising and falling edge (pulse width = trising — traling). The raising edge of the signal marks the
configured engine rotation angle. With the variable pulse width, the values can be allocated to
the engine rotation angle. A maximum of 24 pulses can be configured for this purpose.

The pulse width is known at the time of the active edge, as the falling edge of the signal
precedes the raising edge by the value of the pulse width. The controller calculates the duration
of the falling edge from high-level to low-level and then back to the starting value of the high-
level.

The ASO signal can be inverted via the configuration. It will then be high-active.

You can configure the auxiliary synchronization outputs with the MICT. Refer to the section
Inputs/Outputs — ASO1, ASO2 (Auxiliary Synchronization Outputs) on page 110.
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EXAMPLE

Application of the ASO signal
The following example will illustrate the application of the ASO signal:
- Four-stroke engine with 6 cylinders

— Ignition angle 120° - 120°

Synchronization between MIC6 and Valve Controller

Ignition angle in ASO signal in Pulse duration in
°crankshaft °crankshaft us

1 0/720 718 160

2 120 118 80

3 240 238 80

4 360 358 80

5 480 478 80

6 600 598 80

Schematic Representation (Standard Settings)

Level

*) active edge

The valve controller should receive the active edge of the ASO signal before
the top dead center of a cylinder. The first pulse duration should be twice
as long and thus mark the beginning of a cycle. The ASO signal generated
by the MIC6 increases by 2° each time before the ignition signal from Low
to High, as can be seen in the schematic drawing. This edge is analyzed by
the valve controller as the active edge.

The ASO signal drops in accordance with the configured pulse duration
from High to Low before the active edge. The valve controller then has
already measured the pulse duration of the active edge and can provide
information on the allocation of the signal. In the example shown here, the
first cylinder is marked with a pulse width of 160 ps versus 8o ps for other
cylinders. If the valve controller measures a pulse width of 160 ps, the
subsequent signal is therefore allocated to the first cylinder. The next
signal then corresponds with the second cylinder in the ignition sequence,
etc.
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7.13 lgnition Energy
The ignition energy can be set separately for the start phase and normal operation. Here
different settings can be made for schedules A and B.

You can configure the ignition energy with the MICT. Please refer to the section Timing —
Schedule A/B - Energy on page 106.

7.14 Access Control

The MIC6 has four operating levels, three of which can be secured with different PINs. As a
default setting, the access control is not activated. If the access control for the MICé6 is activated,
itis independent from the access levels that control authorizations within the MICT.

Access control in the MICT and on MIC6

A user is logged in to the Advanced Service access level on the MICT. He
changes a configuration and would like to download the change to the
MICé6. Although he has the full authorization set in the MICT, he is prompted

ERANBLE to log in with the PIN for the Level 3 (Master) on the MIC6.

A variety of functions are at your disposal in the four operating levels of the MIC6 . The figure
below illustrates this:

Level 3: Master

Level 2: Service

Level o: Read Only

Runtime Data

All

Access Control

Login

Level 1: Operator

Runtime Adjustment

Runtime Adjustment

Timing
Energy

Commands

Commands

Reset Position

Configuration

Alarm Commands
Error Commands
Misfire Counters

Set Engine Hous
Set Spark Plug Hours

Timing

Cylinder Individual
Offsets

Download to Device

Access Control

Self Test

All
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Reset All PINs
Enable Access Control
Disable Access Control
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The following functions are available on the different levels:

Level o (Read Only)
Enables read-only access for all users.

Level 1 (Operator)
The user can operate the Alarm Commands, Error Commands, and the Misfire Counter on
this level.

Level 2 (Service)

Only the Service level has access to modifications of the runtime adjustments for Timing and
Energy and the commands Set Engine Hours, Set Spark Plug Hours. The Cylinder Individual
Offsets and the Settings for Self Test can also be executed in this operating level.

Level 3 (Master)

On this level, the Master can, in addition to the other adjustments, modify the Reset Position
and Reset All PINs and Enable/Disable Access Control. This authorization is also needed to
transfer a configuration to an ignition controller.

For information on the access levels in the MICT, refer to the section Access Levels in the MICT on
page 72.
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MICT is an abbreviation for MOTORTECH Integrated Configuration Tool. With the MICT, you can
configure your ignition controller, and you can view and adjust the operating data of your
engine. When working with the MICT, you can press the F1 key at any time to access context-
sensitive help.

If you are using a different version of the MICT than shown in the following sections, the scope of
functions may differ.

8.1 MICT System Requirements

For the installation of the MICT, the following minimum requirements must be fulfilled:
— x86-compatible computer, at least performance class Intel Pentium 4 with 2 GHz
- 128 MB free RAM

- 250 MB free disk space

- USB interface 1.1 or higher

— Display with a resolution of at least 1440 x 900 pixels (WXGA+)

—  Microsoft® Windows 7, Windows 10

8.2 MICT Installation
The software for the installation of the MICT is on the storage device (USB flash drive or CD-ROM)
provided with the ignition controller.

To install the MICT, proceed as follows:
1. Start the installation:

- Viathe menu:
Start the file Start.exe on the storage device. Start the installation routine of the MICT
via Software - Install MICT.

- Directly from the storage device:
Start the installation routine of the MICT directly. It is on the storage device in the
subdirectory Installation and for example named as follows: MICT-2.0.0-setup.exe.

2. Run theinstallation.
Follow the instructions of the installation routine. Note that the license agreement terms
must be accepted before using the MICT.

3. Install the USB driver via the menu as well or directly from the storage device.

— Viathe menu:
Software -> USB Drivers -» Install USB Drivers

- Directly from the storage device:
Start the exe file in subdirectory Drivers(e.g. CDM21226_Setup.exe).

» The MICT is set up. You can connect your PC to the ignition controller via the USB
interface.
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8.3 Access Levels in the MICT
You can open the MICT on your computer via Start -> Programs -> MOTORTECH -> MICT 2.x.x -»
MICT 2.x.x.

After opening the MICT, select the access level for which you have clearance. The access level
controls the options you have at your disposal in the MICT. The password required for access
can be obtained from your MOTORTECH contact person (refer to Customer Service Information on

page 168).
( M Change Access Level @
Access Level
Customer
Service
Advanced Service
Password:
o) o)

The following access levels are available:

Read Only

On this level, the user can open a configuration and transfer it to the device. However, he
cannot make changes to the configuration. The user has read-only access to all other
settings.

Customer
This level enables the configuration of the basic functions required for operation in addition
to the read-only function.

Service
This level contains all functions for a standard installation.

Advanced Service
This level offers full access to all functions of the MICT and is enabled and accessible for
specially trained personnel only.

The following sections describe the options at your disposal with the Advanced Service access
level. If you have registered for a different level, you cannot execute all functions shown.
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8.4 Configuration Pages (Overview)
The configuration pages are divided into the following sections:

B

B unnamed.mic6” (MICE 6:2.24) - MICT

—Eile Device Settings Document Jools Help

raEsNS BN E0 O

Configuration Page

4 Engine

I5 arameters
T
Ignition Outputs

|1 Communication

7 Infarmation

Engine Information

Engine Selection

Engine Manufacturer Series Tye

ATRX E 08 Series E 2842 E302
Bergen Diesel E 26 Series E 2842 E312
Caterpillar E 28 Series E 2842 LE202
Clerk I 32 Series E 2842 LE302
Cooper Bessemer E 2842 LE312
™ E 2842 LE322
Guascor E 2842 LE3R2
Ingersoll Rand E 2848 LE322
Jenbacher E 2876 E302
Liebherr E 2076 E312
A £ 2876 LE202
Nordberg E 2876 1E212
Ruston E 2876 LE302
Sequence £ 2876 TE302
Superior

Waukesha

MOTORTECH does not assume kabiity for
are found.

MAN - E 2842 E312

Engine Type: 12 cylnder 5
stroke V engine

1f your engne i nat avaisbie n the kst contact MOTORTECH service please.

@ COM6 ID MICE 6x2.24 (151 [00024c01]) ADV.SERVICE Full Access Version: 219.00000 —]

Item n Area

The functions in the menu bar, navigation bar and the toolbar as well as the configuration

Menu bar

Toolbar

Navigation bar

Configuration section

Status bar

section will be described in the following.
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The status bar provides you with the following information (from left to right):

— Status display
Indicates whether a connection is established with the device:

— Green: Connection established
— Red: The connection was interrupted and is being restored

— Gray: The connection is not established and is not being restored

— Indication of the interface being used for the connection to the device
— Indication of the device ID
— Indication of the access level of the user in the MICT

- Indication of the operating level for the MIC6 if access control has been activated and the
user has logged on with a PIN.

— Indication of the MICT program version

8.5 Menu Bar and Toolbar
The following functions are available to you via the symbols on the toolbar and the entries in the
menu bar:

Symbol Menu Function
! File -> New Creates a new configuration.
d] File -> Open Opens an existing configuration.
File -> Save / Saves the current configuration.
E File -» Save As
File -» Recent Documents The last five configuration files used are offered for
selection.
File -> Close Closes the current configuration.
File -> Open trace Opens a runtime data record (trace file). Refer to
the section Runtime Data on page 116.
File -> Open pickup trace Opens a saved record of pickup signals (putrace
file). Refer to the section Pickup Trace on page 79.
) File -> Change Access Level Changes the MICT access level for accessing the
( configuration data and functions.
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Symbol

(IR}
|

)

Rev. 09/2019

Menu

File -» Print

File -»> Print To PDF File

File -»> Print Preview

File -» Quit

Device -» Connect

Device -» Disconnect

Device -» Download to device

Device-»> Upload from device

Device -» Runtime data

Device -» Log

Device -»> Runtime
adjustments

Device -» Cylinder individual
offsets

Device -» Self test

Device -» Pickup trace

£ MOTORTECH

Function

Prints the current configuration.

Prints the configuration to a PDF file.

Opens a print preview of the configuration.
Exits the MICT.

Connects to the device.

Cuts the connection to the device.

Downloads configuration data from the computer
to the device. Refer to Working with Configurations
on page 84.

Uploads configuration data from the device to the
computer. Refer to Working with Configurations on
page 84.

Opens the window Runtime Data. Refer to the
section Runtime Data on page 116.

Opens the window Log (Advanced Service only).
Refer to the section Log on page 145.

Opens the window Runtime Adjustments (Service
and Advanced Service only). Please refer to the
section Runtime Adjustments on page 146.

Opens the window Cylinder Individual Offsets
(Advanced Service only). Please refer to the chapter
Cylinder Individual Offsets on page 152.

Opens the window Self Test (Service and Advanced
Service only). For this refer to section Self Test on
page 78.

Loads the automatically recorded pickup signals
from the device. Refer to the section Pickup Trace
on page 79.
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Symbol Menu Function

Device-» Set spark plug Opens the window Set spark plug operating hours.

operating hours

Device -» Set engine operating Opens the window Set Engine Operating Hours.

hours

Device -» Set date and time Opens the window Set Date and Time, in which you
can set the clock in the device.

Device -» Send command -> The misfire counters of all ignition controller

outputs are reset and restarted. Misfires that
previously occurred at the outputs are no longer
displayed.

Reset misfire counters

Device -» Send command -» All operational errors are acknowledged. This can

Acknowledge operational only be implemented while the engine is not

error running.
(Keyboard shortcut: Strg+R)
Device -» Access Control The setup for the access control to the MIC6 is

described in a separate section. Please read the
section Access Control for MIC6 on page 82.

Device -> Temperature Opens the window Temperature Extremes in which
Extremes the minimum and maximum tempe.ratures of the
controller and output boards are displayed.
Settings -> Language Opens the window Select Language in which you
can change the interface language of the MICT.
Settings -»> Online update Opens the window Online Update Settings. Refer to
settings the section Online Update Settings on page 77.

Settings-> Database settings ~ Opens the window Database Settings in which
various databases can be assigned as source for
the MICT.

Settings -» Temperature scale  Opens the window Select Temperature Scale, in
which you can change the unit for the temperatures
shown in the MICT.

Settings -> Display by Not currently used.
cylinders

Document -»> Schedule Curve  Opens the window Schedule. Please refer to the

chapter Schedule Curve on page 154.

76 Rev. 09/2019



I 8 Settings via the MICT = MOTORTECH

Symbol Menu Function
Tools -» Coils Opens a database with information on MOTORTECH
ignition coils.
Help -> Help Opens the online help function.
Help -> About MICT Opens detailed information on the MICT.

8.6 Online Update Settings

Perform regular online updates

MOTORTECH is constantly expanding its databases. Perform regular online
updates to make optimal use of the opportunities that the MIC6 provides.

The MICT uses data from an engine database and a coil database for the configuration. Such
data can be updated with automatic online updates. The settings for the update can be entered
with the following entry in the menu bar:

Settings -»> Online update settings

M Online Update Settings [t

[¥] Enable automatic database updates
[7] Use a proxy to access the web
http-Proxy:

Port: 30

[ stowtog | (updste tow | I

You have the following options:

— Enable automatic database updates
Using the check box, you can enable and disable automatic online updates. As the default
setting, the online update is activated and is executed daily (if an internet connection is
established) at first start-up of the MICT.

— Usea proxy to access the web
Use the checkbox to activate settings for internet access via a proxy server, which you can
then set up by entering http-Proxy and Port.
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- Show Log
With this button, you can open a window in which the online updates performed are logged.

- Update Now
With this button, you manually start an online update.

8.7 Self Test

Operational safety!

If you carry out a self test, it is essential for the gas supply to be switched
off and no more residual gas is left in the combustion chamber. Non-
compliance can result in damage to equipment or injury to persons.

You can run the self test via the MICT to check the order of the wiring and the connection
between the ignition controller outputs and the spark plugs.

Proceed in the MICT as follows:

Device -» Self test

M Self Test = | B
WARNING
[/ In using the salf test feature it is critical that the fuel to the engine has
/1 been shut off and the engne purged of any fuel gas. Fadre to do this

could result in damage to equipment and nearby personnel!

Status Cydes Cyde Time - All Configured Outputs
® Unbited @ period 500000 2| b5
Locked =
1(& Frequency 2.000 15 Hz
D Actve  Outputs Control
@ Al
W Ready

(-] (64] (B9 WE=N

@ COM6 1D MIC6 6:2.24 (1.6.1 (00024<01))

The following information is provided:

Status
The status displays indicate whether the ignition controller is ready for the self test.

— Locked
The ignition controller is in a state in which no self test can be done. For example, there is an
error or a configuration is currently being downloaded into the device.
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Active
The self test is running.

Ready
The ignition controller is ready and the self test can be started.

You have the following options:

Cycles
Determine whether the self test should run unlimited or be terminated after a defined
number of cycles.

Outputs
Define whether all outputs or only a defined output should be fired during the self test.

Cycle Time - All Configured Outputs

Specify the cycle time either as a period or frequency. The value entered always refers to a
complete cycle. That means that all outputs that are configured are fires once per cycle. If
you only set one output for the self test, this would still only fire once per cycle.

Control
Start or stop a self test using the corresponding buttons.

8.8 Pickup Trace
The traces of the pickup signals support you in checking the behavior of the used pickup and
thus, for example, to detect and analyze irregularities or failures.

£ MOTORTECH

Pickup signals are automatically recorded by the ignition controller as soon as they are detected
at the configured inputs. Ten further signals are recorded if an error occurs during operation
(cumulative across all inputs). The recording is then stopped so that the pickup signals just
before the error can be analyzed. The records can be downloaded from the device at any time.

Proceed in the MICT as follows:

Device -» Pickup trace

Rev. 09/2019
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Pickup trace

EXAMPLE - Pickup input 1/4 (cam):
Single event from the camshaft

- Pickup input 2/5 (reset):
Single event from the crankshaft

- Pickup input 3/6 (trigger):

Trigger disc of type N with 160 events from the crankshaft

Example of a pickup trace for a configuration with two redundant pickup
sets, each of them having three pickups:

M MICT Pickup Trace
Eile

Pickup Trace

[E=E =

Time [ms]

1
600

Operation

The following options are available via the menu in the window:

- Open
Opens a previously saved pickup trace.

- Saveas
Saves a pickup trace as a .putrace file.

- Close
Closes the pickup trace.

8o
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£ MOTORTECH

There are the following options for the display of the pickup signals:

— Zoom In/Out

Using the mouse scroll wheel you can zoom in and out of the displayed record range.
Alternatively you can also use the plus and minus keys on the keyboard. With the zoom
function, you can e.g. analyze the trigger signal more precisely (pickup input 3 and 6 in the

drawing).

B! MICT Pickup Trace
File B

Pickup Trace

=

LI

g3 -{m

LILIRTNIRNIRTTATA NN

o

[IRRTRRIRTRAL

NLRNIRRINIRRTNRTATS

LR R A RN AR RN TNR N IRRTNHAAS

[INRTVIRNINANATS

[ININVIRRTRRNATS

[ITIRTERRTRRNATS

(LR N TR AR IR TARNAY

B

L

ILNTRNIRRTATN]

ILNTRNIRRTATN]

T
282 284

T
286

T T
288

Time [ms]

T
290

T
292

— Move displayed range

With the right mouse button pressed you can move the displayed range along the time axis.

— Measuring

You can measure distances and the number of events in the displayed range by holding
down the left mouse button to highlight a section. You can find the following information in

the window:

— Position on the time axis

- Time difference (A) between the two selected points

— Number of events counted in the selected period

M1 MICT Pickup Trace [=lE .
File — — —
Pickup Trace
el
8 1
§2
3 {0
g, . 286,650 ms
2 B = 272.44 115
s input 3 (positive): 3 events, min, peflod: 89,55 5, max. period: 89,82 s
Input 6 (positive): 3 events, min. period: 89.82 ps, max. period: 89.94ps
6 L L 0 LR AL AL LR E AR
T T T T T T T T T T T
282 284 286 288 290 202
Time [ms]
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Error Analysis

The pickup traces support you, for example, in analyzing the following errors:

- Configuration of the pickup does not agree with the wiring (e.g. trigger disc configuration,
allocation of the inputs, allocation of the shafts). In this case, you should compare the
values configured with the signals recorded (see Engine - Pickups — General on page 98).

- One or more pickups have failed.

Pickup trace

The pickup signals are only recorded on the inputs that are configured in
the MICT. If the configuration of the pickup inputs is not valid (e.g. three
signals from the same shaft), no signals are recorded.

8.9 Access Control for MIC6

If the access control to the MIC6 is activated, access to the following areas is possible with a PIN

only:

- Runtime Adjustment (Reset, timing, energy, secondary voltage estimation calibration and
secondary short calibration)

- Commands (Alarms, error commands, set engine/spark plug operating hours, and self test).

- Configuration (Transferring a configuration to the MIC6)

The access control regulates the accesses to the device via the MICT. For explanations
concerning access control of the MIC6 and the delimitation of the access levels in the MICT, refer
to section Access Control on page 69.

The access control functions can be accessed in the menu bar via:

Device -» Access Control

8.9.1 Enable/Disable Access Control

82

Enable/Disable access control

As a default setting, the access control is not activated, and all PINs are set
to oooo. Once the access control has been activated, and the PINs were
changed, these PINs will continue to be used. To activate the access control
again, you will need the PIN for level 3 (Master). It is therefore
recommended to reset all PINs before disabling.

If that was not done, or a system must be unlocked for another reason, a
request key can be issued in the MICT. Refer to the section Reset all PINs on

page 84.

Rev. 09/2019



I 8 Settings via the MICT = MOTORTECH

To enable or disable the access control, proceed as follows:

1. Open the input dialog via Device -»> Access Control -> Enable or Disable access control.
2. Enterthe PIN for the level Master (Level 3).

3. Confirm the input with OK.

8.9.2 Login/Logout

If the access control is activated, you are prompted to log in if you want to execute functions that
are allocated to a specific operating level. In addition, you can log in specifically to an operating
level via the menu bar.

To log into a specific operating level, proceed as follows:
1. Open the input dialog via Device-> Access Control -5 Login.
2. First select the level you wish to log on to.
Enter the PIN for the desired level.
4. Confirm the input with OK.
» You are now logged into the corresponding level and can execute all functions that are
allocated to this operating level without having to log in again.
After completing the log-in, you can log out again as follows:

Device -» Access Control -» Logout

8.9.3 Changing the PIN

To change the PIN for a specific operating level, proceed as follows:

1. Open the input dialog via Device -»> Access Control -> Change PIN.

2. First select the level for which you wish to change the PIN.
3. Enterthe current PIN for the desired level.

4. Enter the new PIN in the two subsequent fields.

5. Confirm the input with OK.

> The PIN for this operating level has now been changed.
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8.9.4 Reset all PINs

To reset all PINs, proceed as follows:
1. Open the input dialog via Device -» Access Control -> Reset all PINs.

2. Ifyou are not yet logged into the Master (level 3) level, you will be prompted to log in with
the relevant PIN.

3. Confirm the input with OK.
4. Toresetall PINs, you will be prompted again to enter the PIN for the level Master (Level 3).
5. Confirm the input with OK.

> Al PINs are now reset to the value oooo.
To reset all PINs, you need the PIN for the level Master (level 3). To be able to unlock a system in
case of emergency that was locked in this way, you have the following option:

1. Inthe menu bar, select the entry Device -» Access Control -> Get reset all PINs request key to
open a window with the same name.

2. Send the request key with the serial number to your service contact person at MOTORTECH
(refer to Customer Service Information on page 168). This key is valid only for the respective
controller and only for a certain amount of time.

> Yourinformation will be verified, and you will receive an authorization key from your
contact person.

3. From the menu bar, select the entry Device -» Access Control -> Set reset all PINs
authorization key to open a window with this name.

4. Enter the authorization key received in the input field.
5. Confirm the input with OK.

> Ifthe input was correct, all PINs are reset to the default value oooo.

8.10 Working with Configurations

To ensure that the MIC6 correctly interprets incoming data and correctly controls the ignition
system, it requires information about the engine and the ignition system. This information is
stored in the MIC6 as configuration data.

You can use the MICT to perform the following for these configurations:
— Create

- Open

- Edit

— Saveasafile

- Download to the MIC6

- Upload from the MIC6
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8.10.1 Create, Open, Save
Click on the symbol to create a new configuration and select the corresponding
T device type. The device type corresponds to the first five digits of the
T arrangement number, which you can find on a label on your device.

! Select Device Type [
Select the device type you want to configure:
4 Ignition Controllers
) MIC3 J
> MIC3+ _— —
> ok TORTECH' —MICES
b MICS —_—
4 Mice RSO = A ©
MIC 6224 (24 outputs) | P/N 12.34.567-8 ] 3
» MICES0 g
4 Stepper Motor Card:
"’\f", otorCads | AIN  6X2.24 XXXX-XXXX-XX-X J g
(ariStep £
= Click on the symbol to open a saved configuration.
QU ! Open Configuration File =]
@Q-\ J. « 05(C) » Configuration Files ~ [ #3| [ Configuration Fies durchsuchen |
Organisieren v Neuer Ordner =+ O @
Name = Anderungsdatum Typ Gréfe
__ engine20.mich 25.05.2016 15:26 MICB-Datei 18 KB
[ enginrld.mitﬁ 25.05.2016 15:26 MIC6-Datei 18 KB
Dateiname: ~  |MIC6 Configuration Files (*.mic »

Click on the symbol to save the configuration currently displayed in the MICT to

E a storage device.
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Compatibility of the configuration files

Configuration files are only compatible for the respective device type, even
if the file extension is identical. For example, files created for a MIC3 cannot
be downloaded to a MIC3+ and vice versa.

To use a configuration for another device, the series and the first four digits
of the arrangement number must match. This information can be found in
the title bar of the configuration and on the respective device:

MIC3 MIC3+
(84t unnamed.micg (MIC3xL.12) SMICT [ M unnamed.mic3((MIC3~ 3xL.13]) MICT
File Device Settings Document Tools H File Device Settings Document Jools E
A & ~ . A e ~ .
AR HLS A TR 3Pl
Coenfiguration Page | Paravctus Configuration Page | Paravctus
4 Engine B 5K 4 Engine B 5K

S MOTORTECH'

GNN 3x1.12§xk-xxxx-xx-x I

E |

|

%
]
I

/OTORTECH'

GNN 3x1.123xk-xxxx-xx-x I

E |

www. motortech.de
www. motortech.de

If, for example, a system is to be changed from a MIC3 to a MIC3+, the
configuration of the MIC3 can be saved as a PDF file. Then a new
configuration file must be created for the MIC3+ and the values from the
PDF file must be entered. Alternatively, the MICT can be opened twice and
the values transferred to a newly created configuration file.

Rev. 09/2019
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8.10.2 Upload, Download
< Click the symbol to upload the current configuration from the MIC6 to the MICT.
g";‘ If applicable, the MICT first establishes a connection to the MIC6 connected.

@CQ Click on the symbol to download the configuration set in the MICT to the MIC6.

= ;?J This function can only be executed while the ignition is not active. This action
overwrites the existing configuration on the device. If applicable, the MICT first
establishes a connection to the MIC6 connected.

Existing configuration is cleared!

If you download a configuration to a MIC6, the previous configuration is
deleted and the new settings are immediately implemented.

® Runtime adjustments
If you change a configuration stored in the MIC6 via runtime adjustments,
the configuration must be re-uploaded from the device so that the changes

NOTIICE are displayed in the MICT's configuration views.

8.10.3 Compatibility Information
¥} Information M

Some optional configuration values could not be uploaded from the device.
Assuming default values.

[Show Details...

If you upload a configuration from the MIC6 to the MICT that does not correspond to the status of
your MICT, or if you open this type of configuration in the MICT, the following situations may
occur:

— Novalues are present in the configuration for certain MICT functions. The MICT assumes the
standard values for these functions.

— The configuration contains function values that are not support by the MICT.
The following situations can occur if you download a configuration from the MICT to a MIC6
whose firmware does not correspond to the status of your MICT:

— Novalues are present in the configuration for certain firmware functions. The firmware
continues to use the preset values for these functions.

— The configuration contains function values that are not support by the firmware.
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If you download a configuration into the MIC6 and are notified of functions that are not
supported by the MICT, you should check the MIC6 settings. Re-upload the configuration from
the MIC6 to the MICT. You can then see which settings are not transmitted to the MICT.

Perform a firmware update, if necessary, and/or update your MICT so that you can use all the
MIC6 functions without restriction.

8.11 Configuration

The window opens after you select the device type for a new configuration or an existing
configuration or have uploaded one from the ignition controller. You can make changes to the
configuration by selecting an entry from the navigation bar. The corresponding configuration
data are then displayed in the configuration section and can be processed. The following
sections will describe the settings and adjustments you can implement in the different areas.

® Indication of invalid entries
An invalid selection or invalid input values are highlighted by pulsating
warning signs on the configuration pages of the MICT. Additional
information is provided in the status bar.
Example:
Configuration Page | Toniton Outputs
4 Engine Output Bank A
Parameters
- Nr. of Outputs: |6 -
Ignition Outputs P
Ignition Coils
Output Angle [7]
Speed Settings. =\ 7
4 Pickups 2 L
General = 2 >| 00
Inputs 3 *] 00
4 Timing P ~] 00
Analog Inputs = =
4 [ Schedule A & *] 0o
General 6 x| 00
Energy 7
4 Miscellaneous
Cemmunication
Infarmatinn T
\GEifimg Angle: 00 - 7200, Default = 00, min.dinance\imﬂe@ COMnfa IDn/a ADV.SERVICE n/a Version: 2331
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8.11.1 Engine — Parameters

M unnamed.mic6" (MIC 6x2.24) - MICT [E=SE= )
File Device Settings Document Tools Help
SN ad =i @ H = -
AHSHS R Ea0 @
Configuration Page Lo L F
« [Engine Engine Sslaction Engine Information
| Parameters| Engine Manufacturer Series Type |New Engine Configuration Selected Engine Summary
. C"’f’fde' Narnes AJRX |E 08 Series E 2842 E302 MAN - £ 2842 E312
Ignition Qutputs Bergen Diessl |E 26 Series E 2842 E312 .
Ignition Coils Caterpillar |E 28 series E 2842 LE202 :mmmmﬂzznm
| Speed Settings Clark |E 32 Series E 2842 LE302
4 [ Pickups Cooper Bessemer E 2842 LE312 Firing Angles
: m E 2842 1E322 g‘fn
General s .
uascor E 2842 LE332 120.0
| Inputs Ingersoll Rand E 2848 LE322 210.0
4 Timing | | senbaches E 2876 E302 00
| Analog Inputs Liebharr E 2876 E312 3500
o [ Schedule A MAN E 2876 LE202 450.0
\ & ) Nordberg E 2876 LE212 ﬁg
S Rusten E 2876 LE302 500.0
Energy Sequence E 2876 TE302 690,0
4 [ Schedule B Superior 0.0
1 General Waukesha
| Energy
| Miscellancous
+ Inputs/Outputs
Alarms
ASOL
1 As02
Inputs
4 Miscellaneous | IMOTORTECH does not assume liabdity for the information in the engine database. Please contact MOTORTECH if discrepandies
| Communication T are found.
| Information If your engine is not avaiiable in the st contact MOTORTECH service please.
& COMS ID MIC66x2.24 (161 [00024c01]) ADV.SERVICE Full Access Version: 2.19.00000

Engine Selection
The MICT holds an engine database with data from various manufacturers and model series.
Select the desired engine manufacturer, series, and type by clicking on the corresponding fields.

Wiring in firing order is assumed as standard. If straight order wiring is supported for the
selected engine, the Wiring dialog opens and you have the opportunity to adapt the output
configuration.
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M Wiring )

Please select the type of wiring you are using.

In case of custom wiring please select wiring in firing order and adjust the output configuration
afterwards.

| wired in firing order
@ wired in straight order (user defined orientation)

Coi 1 71 [o] |o] |1
g| o] [o]]2
af [o] [o]]s
10| |0 o 4
ulof |o||s
2| [o] [o]]|s ol 1
. 58 LTI . 14
ol 712 . 16

change arientationof ral | | dhange hamess | [ change anentaton of rai

Lo ]

You can use straight order wiring, if:

- Wiring takes place via a corresponding MOTORTECH wiring harness and a MOTORTECH
wiring rail. The harness is marked with the following information: PLEASE NOTE! The firing
order needs to be configured directly in the ignition controller. The ignition coils on the
wiring rail are marked with Connector Pin 1 to Connector Pin X. The position of coil1 on the
wiring rail is marked in the view Wiring.

- Wiring of the ignition controller is done corresponding to the instructions in section Straight
Order Wiring of the Ignition Outputs on page 58 (for example with an open wiring harness or
via a junction box).

The configuration of the ignition outputs is automatically adapted corresponding to your
selection. If you want to use a different wiring, these settings must be adapted appropriately.

If the pertinent engine is not available in the database, settings can also be entered by selecting
the corresponding sequence. For this purpose, click on the entry Sequence in the column Engine
Manufacturer and select the firing stroke in the column Series, then the number of cylinders,
and the ignition offset of the engine as needed. After making your selections, the right hand
section Engine Information will display a summary of the parameters selected.

The summarized data are transferred to the subsequent configuration page Ignition Outputs.
The values displayed there can only be changed by users with authorization to access the
Advanced Service level.
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s Engine database
MOTORTECH does not assume liability for the information in the engine
database. Please contact MOTORTECH if discrepancies are found.

NOTICE

New Engine Configuration

Staff with the authorization for the Advanced Service level additionally has the option for
entering the engine data manually, i.e., without selecting entries from the engine database. For
this purpose, click on the New Engine Configuration button and select the engine type, number
of cycles, and number of cylinders in the dialog box opening up. Additional information can be
entered on the configuration page Ignition Outputs.

(8 Dialog ===
Engine Type: [vengoe =
Strokes: [#stroke |
Number of Cyinders: [18 ]

Note: Spedify Firing Order and Firing Angles on the Ignition Outputs Page! |

I
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8.11.2 Engine — Cylinder Names
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File Device Settings Document Tools Help
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! Ignition Outputs
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Speed Settings @ 3
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Inputs
4 Timing
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7 Energy
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Inputs
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To facilitate the allocation of the cylinders during the configuration of the ignition outputs, you
can individually name each cylinder. The schematic representation of the plan view of the
selected engine supports you in this. Enter the following settings:

— Enable Cylinder Names
Activate the checkbox in order to assign cylinder names. In order to use this function, the
number of cylinders must be defined. Establish the number of cylinders either by using a
configuration from the engine database or by creating a new engine configuration via the
corresponding button. Refer to the section Engine — Parameters on page 89. If you have
activated the checkbox, the assigned cylinder names must also be assigned to the
corresponding ignition outputs, before the configuration is transferred to the ignition
controller. Otherwise there will be an error message. Refer to the section Engine — Ignition
Outputs on page 93.

- Bank Name
Enter a name for the respective cylinder bank.

— Cylinder Names
Enter a name for the respective cylinder.

92 Rev. 09/2019



8 Settings via the MICT = MOTORTECH

o%
R !
currently not used

Show banks in reverse order
currently not used

8.11.3 Engine - Ignition Outputs

M unnamed.mict* (MIC6 6x2.24) - MICT [E=TE
File Device Settings Document Tools Help
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Make adjustments to the following settings as needed:

Number of Qutputs
Select the number of outputs for the respective output board.

Column: Cylinder
Select a cylinder. The displayed names are specified on the configuration page Engine —
Cylinder Names.

Column: Output
Select the number of the respective output.

Column: Angle
Enter the firing angle for each output.
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Default Application

If you select from the engine database, the data stored for the selected configuration are
displayed. These data can only be changed by personnel with access to the Advanced Service
level.

New Engine Configuration

If you have created a new engine configuration on the configuration page Engine — Parameters
using the corresponding button, first the number of outputs corresponding to the number of
cylinders are distributed to the output bank A and output bank B. Selecting the number of
outputs enables access to the fields for the configuration of the outputs. We recommend that
you distribute the number of outputs evenly among the output banks and allocate the larger
number to the A output bank if the number is uneven.

By default, the ignition outputs are distributed so that cylinder 1 of the firing order is always
allocated to output bank A with a firing angle of 0°. The further distribution is implemented by
alternating between output bank A and B. The firing angle for each output results from the
addition of the firing interval to the respective previous output.

Operational safety!

Never connect more than one output to each ignition coil, as the output
boards can otherwise be damaged.

The allocation of outputs on the output banks to contacts of the output connector of the device
and the cylinders is determined by the wiring. The user must take the wiring into account during
the configuration; it cannot be checked by the software.

® Interval between two ignitions

The interval between two ignitions on one output bank must be at least
2.8 ms. During the check, the configured overspeed is used in the
calculation.
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8.11.4 Engine - Ignition Coils
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Ignition Coil Type
Select the ignition coil type from the drop-down list. (Without this selection the configuration
cannot be downloaded to the MICé6.)

Only use measured ignition coils

®
To operate the MIC6, only ignition coil types measured by MOTORTECH may
be used. Allignition coils used must correspond to the part number
selected in the drop-down list. Different coil types must not be mixed and

NOTICE -
also no equivalent or replacement types may be used.

If a coil type used is not in the drop-down list, then the MICé is currently not
used.
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Secondary Diagnostics Enabled

The secondary diagnosis can be deactivated and activated for ignition coils that support this
function. If the ignition coil does not support this function, the secondary voltage estimation
calibration and the of the secondary short calibration are not available.

Secondary Voltage Estimation Calibration

A correction value without units can be set for the secondary voltage estimation for every
configured output to increase the accuracy of the secondary voltage estimation for each
individual cylinder. This allows, for instance, different cable lengths on the engine to be
compensated.

The values of the secondary voltage estimation can be changed for each individual cylinder. The
value range depends on the ignition coil. 0.0 is set as the standard value for all cylinders. You
can adjust the secondary voltage estimation while the engine is running in the runtime
adjustments (refer to Runtime Adjustments — Secondary Voltage Estimation Calibration on

page 150).

Secondary Short Detection Calibration

The starting voltage and the secondary short detection sensitivity can be adjusted. You can
adjust the secondary short detection in the runtime adjustments while the engine is running
(refer to Runtime Adjustments — Secondary Short Calibration on page 151).

Secondary Short Enable Voltage
Set the average ignition voltage required to activate the secondary short-circuit monitoring:

- The secondary short detection is always activated at a value of o kV.

- The secondary short detection is always deactivated at a value of 65.535 kV.

Secondary Short Sensitivity
The permitted value range depends on the set ignition coil.

Set the sensitivity of the short-circuit detection e.g. as follows:
— The sensitivity is high at a value of 0.98.

- The sensitivity is low at a value of 1.02.
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8.11.5 Engine — Speed Settings
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— Ignition Release
Enter the release speed for the ignition at which the first ignition is to fire. The value shall
not exceed 1/7 of the nominal speed.

— Security Speed
Enter the security speed (max. half the nominal speed). Below the value entered, the ignition
can be switched on and off as desired. If the ignition is deactivated during operation above
the set speed, the ignition cannot be immediately reactivated. Only when the ignition no
longer reads a speed, i.e., the engine has come to a standstill, can the ignition be
reactivated.

— Nominal Speed
Enter the nominal speed at which your engine is to be operated. With engines that are to be
operated with variable speeds, the max. speed of the operating range must be entered.

— Overspeed
Enter the speed at which the ignition is to be shut off as overspeed protection. With engines
that are to be operated with variable speeds, a speed above the operating range must be
entered.
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- Max. Power-On Speed
Enter the maximum permitted start speed at which the MIC6 starts sending ignition pulses.
Avalue of 6000 rpm is set as the default value: The MIC6 can be activated at the starter
speed and immediately send ignition pulses.
For a value of o rpm the MIC6 can only start sending ignition pulses once it has registered
that the engine is at a standstill.

8.11.6 Engine — Pickups — General
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| Index/Reset Position
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Pickup Redundancy
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/

Aux Pickup Supply Voltage: 240 [3] v /!

& COM6 D MIC6 6x2.24 (L6.1 [00024c0L]) ADV. SERVICE Full Access Version: 219.00000

Please ensure the correct voltage setting

for your application.

® Active pickups

98

Check when using active pickups that the auxiliary supply voltage is
configured for your application.
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- Index/Reset Position
Enter the distance between the first event after the set index/ reset marking and top dead
center. With the button Adjust, you can enter the measured firing angle for a given nominal
value. The system calculates the difference from these values, which is added to or
subtracted from the index/reset position.
If you are using two redundant pickup sets, enter the value for pickup set 1 here. The
corresponding value for pickup set 2 is determined by the ignition controller. Details can be
found in the information box Setting up a redundant pickup system.

- Enable Redundancy
Activate the checkbox to be able to define two redundant pickup sets in the view Engine —
Pickups — Inputs. For general information on this, read the section Redundant Pickup System
on page 60.

— Aux. Pickup Supply Voltage
Enter the supply voltage with which the active pickup is to be operated. A value between 5V
and 24 V is possible. The set auxiliary supply voltage is independently made available on
the inputs Pickup 1 Power to Pickup 3 Power and on the inputs Pickup 4 Power to Pickup 6
Power. If two redundant pickup sets are configured correspondingly, failure of the auxiliary
supply voltage affects just one pickup set.

@ Setting up a redundant pickup system
The index/reset position can be only configured for pickup set 1. For the
pickup set 2, the index/reset position is determined automatically the first

—_— time the engine is started after the ignition controller has been configured.
NOTICE A
The following procedure must be ensured:
1. Download the configuration to the ignition controller.
2. Start the engine.
» Theignition controller synchronizes both pickup sets.

> Inthe window Runtime Data — Overview, the status display
Available in the area Pickup Redundancy is illuminated green if the
synchronization has been successfully completed.

> Theindex/reset position for the pickup set 2 is now determined and
stored automatically.

The saved position is cleared when a configuration is downloaded to the
device again. The index/reset position for the pickup set 2 cannot be
configured manually.
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8.11.7 Engine — Pickups - Inputs
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- Pickup Set

Assign the pickup to pickup set1 or 2. Read the section Redundant Pickup System on page

60 for general information on pickup sets.
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Type

You can select the type of events that will occur on this input for each pickup input. Type and
number of events are defined by the discs or ring gears used. If you decide not to use a
pickup input, select the entry None from the list. You can set the following types:

N

Disc, which causes a uniformly distributed number (N) of events (per rotation), e.g. a ring
gear with 160 teeth (N=160).

N+1

Disc type N with one additional event, e.g. a disc with 12 teeth and one additional tooth for
the index signal (N=12).

N+1 extended index range

Disc type N with an additional event, e.g. with one disc with 12 teeth and one additional
tooth for the index signal (N=12). The permitted range for the index signal is expanded to

75 % of the tooth period. An incorrect direction of rotation of the engine cannot be detected
by this setting.

N-1

Disc type N, where one event is missing, e.g. a ring gear with 160 teeth on which one tooth
was removed (N=160). This missing event is used to determine the index signal

N-2

Disc type N, where two consecutive events are missing, e.g. a ring gear with 60 teeth on
which two teeth located next to each other were removed (N=60). This missing event is used
to determine the index signal.

N Magnets, Single Magnet

You will always use these two types together for a disc with magnets having opposite
polarity. A magnet with a fixed number of magnets (N), all of which are arranged at equal
distances on the disc, has a reverse polarity. Thus, the disc supplies two signals that can be
analyzed by a pickup.

Single Event

Disc that supplies a single event, e.g., a disc with one tooth or one magnet.

- Number of Events
Enter the number of events that occur on the pickup if more than one event is expected.
For the types N+1 and N-1, enter the value for N and not the total number of events. With
the type N Magnets, the number of magnets with identical polarity must be entered.
The number of events must lie between 3 and 500. Additionally, it must be ensured that
the sum of the frequencies at the pickup input does not exceed the limit of 15 kHz at the
pre-set overspeed.

- Speed
Select whether the respective pickup will pick up the signal off the camshaft or the
crankshaft.
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- Active/Passive
Select the pickup to be used from the pre-defined pick list:
Passive
passive pickup
Active (low)
active pickup with high level as quiescent level
Active (high)
active pickup with low level as quiescent level
— Speed [RPM]
For passive pickups, the pre-trigger voltage can be set so that it is speed-dependent.
See also the following example.
—  Pre-Trigger
Enter a value between 0.1V and 7.5 V for each pickup to set the pickup sensitivity level.
Signals that fall short of the set voltage will not be analyzed. A low pre-set value
therefore results in a high sensitivity level, a high value results in a low sensitivity level.

Speed-dependent pre-trigger voltage
For a passive pickup, the pre-trigger voltage is defined as follows:
— Speedi: 150 RPM; Pre-trigger voltage1: 2 V

EXAMBLE Speed2: 1000 RPM; Pre-trigger voltage2: 5V

The result is the following curve:

Pre-trigger voltage

W)

Speed
(RPM)

oyl FEAPRRRR S | KA S S

0 1000
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8.11.8 Timing — Analog Inputs

MOTORTECH
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® Auxiliary supply voltage

Check with the configuration of the analog inputs, that the set auxiliary
supply voltage corresponds to your application.

NOTICE

Analog Inputs Base Settings

The ignition timing adjustment can be made using two analog input signals, which can be set

within the following limits:

Analog current signal: 0-20 mA

Analog voltage signal: 0-10 V
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Set the Upper Limit and Lower Limit of the signals corresponding to your connected device. Also,
you have the option to enter a Failure Threshold. If the signal does not reach this value, it is
classified by the ignition controller as failure (e.g. wire break). The error value configured in the
schedule was set for the affected input. To reset the error state, a threshold will need to be
exceeded. This threshold value is calculated as follows:

Threshold to reset the error state = 0.5 x (Lower Limit - Failure Threshold) + Failure Threshold

You set the analog input that will be used and which timing adjustment results from the analog
signal for the two possible schedules. Refer to the section Timing — Schedule A/B — General on

page 104.
Aux. Analog Input Supply Voltage

An auxiliary supply voltage can be configured for the analog inputs. Enter a voltage value
between 5V and 24 V.

8.11.9 Timing — Schedule A/B — General
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Schedule A General Settings

The MIC6 offers two schedules for implementing the necessary settings for the timing of the
engine. The schedules A and B can be used for dual fuel operation, for example. The system
switches between the schedules via the input Schedule A/B. If only one schedule is configured,
the switch is ignored. The configuration options for schedule B are identical to those for set A.

— Enable Schedule
The settings are enabled or disabled by checking/unchecking the box. One schedule must
always be activated.

— Description
Enter a description for the schedule (e.g. natural gas for the setting for this type of gas).

Limits

Enter the limits of the timing point at which the ignition can fire. The timing points of the outputs
will be limited to this range relative to the respective top dead center of the pertinent cylinder.
The global timing can then not be shifted beyond this range by any adjustments.

Base Timing
Enter the timing specified by the engine manufacturer. This point must be within the limits
entered and is a static portion of the global timing.

Potentiometer Function
(the standard version of the MIC6 has no potentiometer)

Analog Current Input / Analog Voltage Input
The analog inputs can be enabled and disabled by clicking. If you have the choice, you should
prefer the analog current input due to its lower sensitivity to faults.

Enter the values by which the adjustment is to be implemented for the corresponding input
signal. An error value can be entered for the signals if a failure threshold has been defined for
the corresponding input in the window Timing — Analog Inputs. If the signal is below the failure
threshold, the timing is offset by the error value. The adjustment remains until the signal again
exceeds the threshold to reset the error state (see Timing — Analog Inputs on page 103).

Cylinder Individual Timing Limits

Enter the maximum possible cylinder individual offset. This setting limits, among other things,
the adjustment possibility in the window Cylinder Individual Offset. In addition the limits also
apply to the corresponding adjustment signals from all other sources, for example via the field
buses.

Speed Curve

The speed curve can be activated and disabled by mouse click and offsets the timing depending
on the speed. A max. of eight speed points are available. If you select a number of points from
the list, the corresponding number of fields is activated for input.
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The first speed point is always set to o RPM. All other timing points are assigned with the value
by which the signal is to be offset when the respective speed is reached. For the last speed
point, the timing of the nominal speed should be entered. Please note that the speed points
must always be entered in ascending order.

8.11.10 Timing — Schedule A/B - Energy
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You can make different energy settings for the start phase and normal operation.

Start Phase

Set the start phase of your engine. To do this you can enter a Speed Limit, a Time Limit or both. If
you enter values for both criteria, both values must also be exceeded, so that the ignition
controller classifies the start phase as ended and sets the values for normal operation. If you
only want to use one criterion, set the other value to o. If you do not want to define any start-up
phase, set both values to o.

Enter values specific to your application for the Spark Duration, the Spark Intensity and the
Maximum Breakdown Voltage. The maximum breakdown voltage corresponds to the maximum
voltage expected during operation.
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Normal Operation
If the criteria specified for the start phase are exceeded, the settings for normal operation are
used by the ignition controller. Make the energy settings the same as for the start phase.

Energy Limit

You can use the field Energy Limit to limit the output energy made available by the ignition
controller. If the set output energy is no longer sufficient to reach the set energy values (spark
duration, spark intensity, max. breakdown voltage), the spark duration is reduced
correspondingly.

® Required supply voltage for energy control
Depending on the output configuration and the energy settings, for a
correct energy control, a higher supply voltage than the minimum 10 V DC

sufficient for operation of the device can be necessary. If this is the case,
the required supply voltage is displayed in a notice in the window Timing —
Schedule A/B — Energy.

NOTICE

8.11.11 Timing — Miscellaneous

M unnamed.mic6* (MIC6 6x2.24) - MICT s

File Device Settings Document Tools Help

AL NN EO QO

Parameters Advi 0.4

[ configuration Page
# Engine
Cylinder Names Ret: 0.6
Ignition Outputs
Ignition Coils
Speed Settings
4 Pickups
General
Inputs
4 Timing
Analog Inputs
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4 Schedule B
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| Miscellaneous’
4 Inputs/Outputs
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ASOL
AS02
Inputs
4 Miscellaneous
Communication

Information

& COMn/a IDn/a ADV.SERVICE n/a Version: 2.19.00000
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You can specify how fast the changes of the timing should be executed.

— Maximum Firing Angle Change Per Cycle
Specify the maximum degrees per cycle that the ignition timing may be shifted by for both
directions, i.e. between two firings of a cylinder. If the specified ignition timing adjustment
is larger than the given value, it is divided among several cycles.

8.11.12 Inputs/Outputs — Alarms

M unnamed.mic6* (MIC6 6x2.24) - MICT (=& )
File Device Settings Document Tools Help
3 d 5 H . = -
AHEFS 0 %R E0
Configuration Page A GECSetge
4 [Engine Jers
P, i i Alarm 1
'arameters 1: analog current input < threshold (Cur
| Cylinder Narmes 2: speed > threshold (Speed) R
Igniticn Outputs i’”’“‘“‘: Description:  Current
: unuse )
Ignition Coils Siised Function: |analog curent input < threshold X,
Speed Settings 6: unused Threshold: 3.0 mA
4 1 Pickups 7: unused i P =
General g_:u’“‘“: el
 unuse Delay: 0 ms
- Kt | |10: unused
* Eiiing | [12: unused Settings
Analog Inputs 12: unused
4 [0 Schedule A 13; unused Engine Sutdown
General 14: unused 7] Permanent - Keep output activated untl alarm is admowdedged
= 15: unused =
[ Log Events
Energy 16: unused i
4 [ ScheduleB o
General i -
GPO1 [V GPO2 GPO3
Energy
Miscellaneous
4 Inputs/Qutputs.
| Alarms i - |
ASO1
ASO2 GPO Settings
bigats | GPOL: |NORMALLYOPEN ¥
4 Miscellaneous | — S
| Communication GPO2: |NORMALLY.OPEN.. %
Information P03: [NORMALLY OPEN_ ~ |
& COM6 ID MIC66:2.24 (1.6.1 [00024c01]) ADV. SERVICE Full Access Version: 2.19.00000

The MIC6 ignition controllers include a total of 16 configurable alarms that can be allocated to
the general purpose outputs.

- Description
You can enter any desired description for an alarm. The description is used for logging the
alarms that have occurred in the event list in the MICT.

— Function
The alarms can be used depending on the following functions:

- Unused
— Speed above threshold / below threshold

- Engine operating hours above threshold / below threshold
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- Spark plug operating hours above threshold / below threshold

— Warning active

- Error active

- Temperature above threshold / below threshold

- Analog voltage input over threshold / under threshold

- Analog current input over threshold / under threshold

- Global ignition timing above the threshold / below the threshold

- Supply voltage above threshold / below threshold

- Min. spark duration above threshold / below threshold

- Misfire rate (primary, single output) over limit

- Misfire rate (primary, all outputs) over limit

- Misfires per second (primary, all outputs) above threshold

- Consecutive misfires (primary, single output) above threshold

- Misfire rate (secondary, individual output) above threshold

- Misfire rate (secondary, all outputs) above threshold

- Misfires per second (secondary, all outputs) above threshold

- Consecutive misfires (secondary, single output) over the limit
- Threshold

Input of desired threshold value.

— Hysteresis
Input of desired hysteresis value.

- Delay
Input of desired delay. The threshold value defined in the alarm must have been exceeded or
not reached for a longer period than the specified time for an alarm to be triggered. If a
corresponding value occurs for a shorter period of time, no alarm is triggered.

— Engine Shutdown
If this checkbox is checked, the ignition is switched off as soon as the alarm is triggered.
The shutdown causes an operational error. Therefore the checkbox should not be checked, if
the alarm Error active is selected.

- Permanent - Keep output activated until alarm is acknowledged
If this box is checked, the output remains permanently active until the alarm is
acknowledged. If the box is not checked, the output remains active only for as long as the
alarm is active.

- LogEvents
If this box is checked, the event list records when the alarm occurred or when it was
acknowledged.
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- Outputs
Activate one or more checkboxes GPO1, GPO2, GPO3 to enable switching of the
correspondent general purpose output in case the alarm is triggered.

— GPO Settings
Configure the general purpose outputs as normally closed or normally open.

8.11.13 Inputs/Outputs — ASO1, ASO2 (Auxiliary Synchronization Outputs)
M unnamed.mic6* (MIC6 6x2.24) - MICT [E=E )

File Device Settings Document Tools Help
AR S A %WEO G
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4
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4 Schedule A 3
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Miscellaneous 1 10 23
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Inputs
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) COM6 IDMIC66:x2.24 (L6.1 [00024c0L]) ADV.SERVICE Full Access Version: 219.00000

With the auxiliary synchronization outputs, freely definable impulses depending on the angle of
the crankshaft can be generated. For the outputs, the user defines whether the angle will be
absolute or based on the global timing. The outputs can generate between 1 and 24 impulses
and only be assigned to one system at a time. One example of the application of the ASO output
for a detonation controller can be found in section ASO: Auxiliary Synchronization Outputs on
page 67.
— No. of Points
Select the number of impulses from the No. of Points list. Please note that the DetCon
detonation controller devices require a single impulse with 200 ps synchronous with the
first cylinder in the ignition sequence. You can get this setting via the button Configure for
DetConz/2o0.
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Angle Reference

Select from the Angle Reference drop-down list whether the angle shall be based on the
absolute angle of the crankshaft or the actual angle depending on global timing. Then, enter
the trigger angle for each impulse and the length of the impulse in ps. This setting also
determines when ASO signals are generated. For this, also read the information box ASO
signals depending on the ignition release.

Mode

Select the mode for the ASO signal.
In the default setting Trailing Rising Edge (default), the signal is low-active.

Level
'y
t1 t2 13

High —r ~—r ---TH
! 1

*)ﬂ T i r's
]
Low 1 .

°crank'5haft

In the setting Trailing Falling Edge (inverted), the signal is high-active.

Level
t1 t2 t3
High $ > ==
)y + lL
Low =1 >

°crankshaft

*) active edge marks the configured engine rotation angle

Maximum impulse duration

Please note that the duration of the impulse can be entered as max. 300 ps.
Input of higher values will not be accepted by the system.
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® ASO signals depending on the ignition release

The setting in the drop down list Angle Reference determines when ASO
signals are generated:

NOTICE — Actual Angles Depending on Global Timing
ASO pulses are only transmitted if ignition is active, indicated by the
green status display Firing Active in the window Runtime Data —
Overview.

— Absolute Timing
ASO pulses are generated independently of the ignition release as soon
as the synchronization of the pickups is accomplished.

8.11.14 Inputs/Outputs — Inputs
([ unnamed.micé (MICG 6:2.24) - MICT [E=E )

File Device Settings Document Tools Help
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Information

& COMé IDMIC66:2.24 (161 [00024c0L]) ADV.SERVICE Full Access Version: 2.19.00000

Various functions can be selected for the general purpose input GPl1:

- Disabled
The input GPIl1 will not be used.
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— CANreset (1 s pulse), device reset (5 s pulse)
This feature allows (e.g. a master control) to trigger a CAN reset and/or a device reset
externally using a high impulse. A high impulse of 1 second leads to a reset of the CAN driver
and a high impulse of 5 seconds leads to a device reset.

- Warning acknowledge (< 3 s high), error and alarm acknowledge (> 3 s high), device reset

(> 15 s high)

This feature allows (e.g. a master control) warnings, errors, and alarms to be confirmed
and/or device reset to be triggered externally using a high impulse. If the high impulse is
shorter than 3 seconds, all warnings will be confirmed. If the high impulse is longer than
3 seconds, all errors and alarms will be confirmed. If the high level lasts for more than

15 seconds, this triggers a device reset.

8.11.15 Miscellaneous - Communication

B unnamed.mic6* (MIC6 6x2.24) - MICT
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CAN1/2
Clicking on the CAN1 or CAN2checkbox enables or disables the respective CAN interface on the
device.

- ALL-IN-ONE (J1939)/)1939/CANopen
Select the desired protocol, depending on whether you want to set the communication for
the ALL-IN-ONE or for another device. For example, for a connection to the PowerViews,
select CANopen.

— ]1939 Settings
The J1939 source address can be assigned between o and 253. Note that IDs cannot be
assigned more than once. The Address Filter can be used to set that broadcast PGNs are only
accepted from one or two specific source addresses you have entered. If the filter is
deactivated, the broadcast PGNs are accepted from all source addresses.

— CANopen Settings
The CANopen node ID can be assigned between 1 and 127. Note that IDs cannot be assigned
more than once.

- Baudrate
Select the desired data transfer rate from the list. The baud rate can be defined between
50 kbit/s and 1 Mbit/s, the recommended value being 250 kbit/s.

RS485

Clicking on the field RS485 enables or disables the Modbus interface on the device.

- Baudrate
Select the desired data transfer rate from the list. The Modbus baud rate can be defined
between 9,600 bit/s and 115,200 bit/s, the recommended value being 19,200 bit/s.

- Parity
Define if a parity bit is used and if the parity is to be even or odd.

— Stopbits
Determine if one or two stop bits are to be sent. Two stop bits can only be sent if no parity
has been selected.

- Modbus Address
The Modbus address can be assigned between 1 and 247. Note that IDs cannot be assigned
more than once.

-  Mode
Define if the data are transferred in the ASCII or RTU mode.

Setting the transfer rate

Please note that all devices connected with a bus must be set to the same
transfer rate.
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Information on protocols

Please contact your MOTORTECH contact person if you require more
information on the CANopen®, J1939 and Modbus protocols.

8.11.16 Miscellaneous — Information
This configuration page can be viewed by all users, but changes can only be made with
authorization for the Service access level.

( M unnamed.mic6* (MIC6 6x2.24) - MICT [EIM
File Device Settings Document Tools Help
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Site and Module
In this section, enter information on the system and the module for which the configuration will
be used.
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Service Contact

In this section, individual contact data can be saved that can be called up and displayed via
MICT.

8.12 Runtime Data

Click on the symbol to open the window Runtime Data. The following sections
will give you an overview of the data you can view on the individual tabs.

You can print and record the runtime data. For this purpose, the following functions are at your
disposalin the toolbar in the window:

Symbol Function

Prints the runtime data.

=y
)9
/;:5 Prints the runtime data to a PDF file.
=7 Opens the print preview.
<
N Starts the runtime data trace.
(¥
N Stops the runtime data trace.
8
_5\1: Acknowledges the operational errors. If an operational error is acknowledged,
P

all alarms are also simultaneously acknowledged. The symbol is grayed out if
no acknowledged error is present.

Save runtime data locally

You should always save runtime data on the local computer and not on a
network drive or external storage device. Trace files can only be moved
freely once the recording is stopped.
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8.12.1 Runtime Data — Overview
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Control Output
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2 GPI @ cro3
Failure
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@ Ignition Cutput
Timing Misfire Rate
Global Timing Point - BTDC Primary Secondary
IR Single Output - % - %
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& COMS D MIC66x2.24 (1.6.1 [00024c01]) Lifetime: 42:10:05.922

In this screen, you can find the following information:
— Speed Indicator (analog)

- Red pointer
Displays the current registered speed

- Yellow pointer
Displays the maximum registered speed since last starting the engine

— Green pointer
Display of set overspeed

— Speed Indicator (digital)
Digitally displays the current speed

Rev. 09/2019
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— Global Timing Point
Digital indication of the current global timing

— Operating Hours

— Spark Plugs

Indicates the current operating hours of the spark plugs
- Engine

Indication of current operating hours of the engine

— Device State
The status of the device is shown by the following status displays:

Idle The ignition is ready and waiting for pickup activity.

Synchronizing Pickup signals are being received and analyzed.

Firing Active The ignition is active.

Firing Locked Pickup signals are being received and are valid, ignition is not
released.

Wait for Stop Pickup signals are being received, the ignition fired above the

security speed, and the ignition release was retracted. The
engine must now come to a standstill.

Configuration The device is being configured.

Self Test The self test is running (refer to Self Test on page 78).

Start Phase The engine is in the configured start phase (refer to section
Timing — Schedule A/B — Energy on page 106).

Warning A warning has occurred (refer to Warnings on page 135).

Error An error has occurred (refer to Failure on page 137).

Alarm A configured alarm has occurred (refer to Alarms on page 136).

- Pickup Redundancy

— Enabled
The green status display indicates that in the view Engine — Pickups — General of your
ignition controller’s configuration, the checkbox Enable Redundancy has been activated.

— Available
The green status display indicates that both pickup sets are synchronized and working
error-free.

—  Pickup Sets
The status display signals the following states:

— Green: The pickup set works without errors.
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Yellow: The pickup set is being synchronized.

Gray: No signals are received from the pickup set.

- Control

Firing Enabled
The green status display signals that the firing is active.

Schedule A/B
The green status display shows which parameter settings are currently used.

GPI1
The status display shows the status of the input signal.

— Output

GPO1, GPO2, GPO3
A green status display indicates that the corresponding general purpose output is
switched on.

— Failure

Analog Current Input

The red status display signals that the set failure threshold for the input has been
reached. If the lower limit of the signal is reached again, the status display is again
gray.

Analog Voltage Input

The red status display signals that the set failure threshold for the input has been
reached. If the lower limit of the signal is reached again, the status display is again
gray.

Ignition Output

The red status display signals a current misfire on at least one output. With a yellow
status display at least one misfire has occurred at one output since the last reset of the
counter.

- Misfire Rate
The misfire rate is displayed for the primary side and secondary side. The misfire rate on the
secondary side is only displayed if the secondary side diagnosis is activated (refer to
section Engine — Ignition Coils on page 95).

Single Output
Displays the misfire rate of the output for which the most misfires were registered
during the last 32 cycles.

All Outputs
Displays the misfire rate for all the ignition outputs for the past 32 cycles.

The number of misfires per second are calculated by the MIC6 as follows:
2-stroke engine: Number of currently misfiring outputs x RPM / 60
4-stroke engine: Number of currently misfiring outputs x RPM / 60 / 2
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8.12.2 Runtime Data — Timing
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In this view, the system displays all values and settings in the left hand section that influence
the timing. On the right, the current input values (e. g. potentiometer, analog current and
voltage input), leading to the displayed timing adjustment, are displayed numerically and in bar
charts. The value for the speed curve is shown by curve progression set in the configuration.
Refer to the section Timing — Schedule A/B — General on page 104. The timing correction can be
implemented for the runtime. Refer to the section Runtime Adjustments — Timing on page 148.

In the lower range, the maximum, minimum and average of the cylinder individual offsets are
also displayed.
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8.12.3 Runtime Data — Ignition
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Col Data Version: 1
D COM6 D MICE6x2.24 (161 [00024c01]) Lifetime: 42:08:44.922

The following information is provided:

— Column: Output
Designation of the output

— Column: Cylinder
If cylinder names are assigned, these are displayed.

— Column: Estimated Secondary Voltage [kV]
Secondary voltage determined by the ignition controller of the respective output.
The secondary voltage is used to determine deviations between the individual outputs.
These indicate a possible problem at this output (e. g. problems in the area of the spark plug
or the cylinder).
If you have set the ignition coils (refer to Engine — Ignition Coils on page 95) for which a
secondary voltage estimate does not seem possible "---" appears.
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- Column: Misfire

The red status display signals a current misfire at the respective output. With a yellow status
display at least one misfire has occurred at the respective output since the last reset of the

counter.

The coil data version configured in the MIC6 is displayed under the ignition runtime data.

8.12.4 Runtime Data — Bank A and B

M MICT - Runtime Data o | B e
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» - il E o o =i
s S SN B o o HE B3
A1 = N O o o ==
a8 -~ N EE > o ==
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& COMS ID MICS 6x2.24 (161 [00024¢01])) Lifetime: 42:09:36.922

The following information is provided:

— Column: Output
Designation of the output

- Column: Cylinder
If cylinder names are assigned, these are displayed.
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-  Column: Angle
Current output firing angle

— Column: Min. Spark Duration
Minimum spark duration of the outputs

- Column: Energy Output
Current energy release of the output

— Columns: Misfire
Status display for the different types of misfires (primary, secondary, open, short circuit). In
case of misfire, the respective status display turns red, otherwise it is gray. With a yellow
status display misfires have occurred since the last reset of the counter.
If you hold the pointer over the status display, an overview of the misfire counter of the
respective output is displayed for all types of misfires. A maximum up to 255 is counted per
type of misfire. The counter manually resets using the menu item Device-» Send command -»
Reset misfire counters. When starting the engine and starting the self test the counters are
automatically reset.

You have the following options:

— Relative/Absolute
Select via the option, whether the firing angle should be displayed absolute or relative.
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8.12.5 Runtime Data — States
MI MICT - Runtime Data (=B ] |
A 5y

| Overview | Tming | Ionition | BankA | BankB | States | Messagelog | Di ics | | jon_|

Operating Hours  Time Status Message
42:09:13762 2016-06-13 08:28:27 Analog current input failure (current: 0.0, failure thresheld: 3.0, failure reset threshold
42:03:18.780 2016-06-13 08:22:32 Cylinder individual timing limited to range 0.0 ATDC .. 0.0 ATDC.
42:09:13859 2016-06-13 08:28:27 PUL: Synchronization problem.

42:09:13933 2016-06-13 08:28:27 PUL: No signal.

42:09:13.061 2016-06-13 08:28:26 PU2: Synchronization problem.

42:09:13221 2016-06-13 08:28:26 PU2: No signal

42:09:13.301 2016-06-13 08:28:26 PU3: Synchronization problem.

420913381 2016-06-13 08:28:26 PU3: No signal.

42:09:10816 2016-06-13 08:28:24 PU3: Missing Signal. Signal timeout occurred (events counted 383).

& COM6 ID MICE 6x2.24 (1.6:1 (00024c01)) Lifetime: 42:09:13.922

Status messages are listed in the States view.
The following information is provided:

— Operating Hours
Operating hours counter reading at the time of message
- Time
Date and time of the message (see following information box)

— Status Message
Message text
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® Date and time of ignition controller
The date and time can be individually configured for each ignition controller
and saved in the device. The device does not adjust automatically for

daylight savings time. Hence, deviations may occur between the device

NOTICE . N :
time and the time on the computer used to access the device.

Correspondingly, the times indicated for the states, messages, and in the
log reflect the time of the ignition controller. The current time of the ignition
controller is shown in the view Runtime Data — Information. You can adjust
the time of the ignition controller by entering the desired time in the menu
via Device -» Set date and time.

Status messages are displayed in black if they are current. If a status is reset, the status
message is displayed gray for 10 seconds before it is deleted from the list.

The following status messages can be displayed:

Status message Description

Alarm shutdown caused by The engine was shut down by an alarm, as the configured

alarm number. limit was exceeded or not reached. You can view the alarm
number in the configuration (see Inputs/Outputs — Alarms
on page 108).

Analog current input failure Failure threshold set for analog current input was
(current: x mA, failure threshold: undershot (see Timing — Analog Inputs on page 103).

y mA, failure reset threshold: The following values were obtained: Current: x mA, failure
z mA). threshold: y mA, threshold for failure reset: z mA.

Analog voltage input failure Failure threshold set for analog voltage input was

(voltage: x V, failure threshold:  undershot (see Timing — Analog Inputs on page 103).
y V, failure reset threshold: zV). The following values were obtained: Voltage: x V, failure
threshold: y V, threshold for failure reset: z V.

Aux analog input supply voltage Error in auxiliary supply voltage of analog inputs (see

failure (voltage: u V, desired Timing — Analog Inputs on page 103). The following values
voltage: v V, failure threshold: were obtained: Voltage: u V, expected voltage: v V, failure
xV, failure reset threshold: y V). threshold: x V, threshold for failure reset: y V

Aux pickup supply voltage Error in auxiliary supply voltage of pickup (see Engine -
failure (voltage: u V, desired Pickups — General on page 98). The following values were
voltage: v V, failure threshold: obtained: Voltage: u V, expected voltage: v V, failure

x V, failure reset threshold: y V). threshold: x V, threshold for failure reset: y V
Configuration data checksum The checksum of the configuration data is faulty. The
error. Using default default configuration is used. This message may appear
configuration. during an upgrade/downgrade. Check your configuration

data and the MICT version being used. Then download the
configuration to the device once again.
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Status message Description

Configuration invalid. Using
previous configuration.

Current sensor of output bank
name failed.

Cylinder individual timing

limited to range timing 1 ..

timing 2

Device started after supply
voltage failure.

General error number.

Global timing x° crankshaft

limited to range y° crankshaft ..

2° crankshaft.

Incompatible coil parameters
received, secondary voltage
diagnostics disabled.

Output board identification

failed due to a checksum error.

Output board identification
failed due to incompatible
hardware.

Output board identification
failed due to missing data.
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The configuration is invalid. The previous configuration is
used. This message may appear during an
upgrade/downgrade. Check your configuration data and
the MICT version being used. Then download the
configuration to the device once again.

The current sensor of output bank name failed. Restart the
ignition controller. If the error occurs again after restarting
the device, please contact MOTORTECH.

The cylinder-individual offset has reached the set limit
(Timing 1 ... Timing 2 (see Timing — Schedule A/B — General
on page 104).

The device was started after a failure of the supply voltage.
Please check the power supply of the device where
applicable.

General error number. Restart the ignition controller. If the
error occurs again after restarting the device, please
contact MOTORTECH.

The global timing (x° crankshafft) is located outside the
configured limits (y° crankshaft .. z° crankshaft; see Timing
— Schedule A/B - General on page 104).

Incompatible coil parameters received. The secondary
voltage diagnostics have been disabled. This message may
appear during an upgrade/downgrade. Check your
configuration data and the MICT version being used. Then
download the configuration to the device once again.

The identification of the output board failed due to a
checksum error. Restart the ignition controller. If the error
occurs again after restarting the device, please contact
MOTORTECH.

The identification of the output board failed due to
incompatible hardware. Restart the ignition controller. If
the error occurs again after restarting the device, please
contact MOTORTECH.

The identification of the output board failed due to missing
data. Restart the ignition controller. If the error occurs
again after restarting the device, please contact
MOTORTECH.
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Status message Description

Output board identification The identification of the output board failed due to
failed due to unknown error unknown error number. Characteristic data of the output
number. board could not be read, they are defective or do not match

the device. Restart the ignition controller. If the error
occurs again after restarting the device, please contact
MOTORTECH.

Output board identification The identification of the output board failed due to

failed due to unknown hardware. unknown hardware. Characteristic data of the output board
could not be read, they are defective or do not match the
device. Restart the ignition controller. If the error occurs
again after restarting the device, please contact
MOTORTECH.

Pickup configuration invalid. The pickup configuration is invalid. This message may
appear during an upgrade/downgrade. Check your
configuration data and the MICT version being used. Then
download the configuration to the device once again.

Power failure detected on output Power supply fault in output board at output

Anumber/Bnumber. Anumber/Bnumber was detected. Restart the ignition
controller. If the error occurs again after restarting the
device, please contact MOTORTECH.

Power output (x W) exceeded The power output (x W) exceeded failure threshold (y W) at

error threshold limit (y W) at a a supply voltage of z V. Increase the supply voltage and

supply voltage of z V. check the energy settings (see Timing — Schedule A/B -
Energy on page 106).

Power output (x W) exceeded The power output (x W) exceeded warning threshold limit
limit (y W) at a supply voltage of  (y W) for longer than two minutes at a supply voltage of z V.
z V. Increase the supply voltage and check the energy settings

(see Timing — Schedule A/B — Energy on page 106).

The power output (x W) exceeded The power output (x W) exceeded warning threshold limit

permanent limit (y W) at a supply (y W) for longer than three minutes at a supply voltage of

voltage of z V. z V. Increase the supply voltage and check the energy
settings (see Timing — Schedule A/B — Energy on page 106).

PUnumber: Faulty index. The pickup PUnumber has an error in index. Check the
pickups and the corresponding configuration (see Engine —
Pickups — General on page 98). Furthermore, also pay
attention to the instructions in the section entitled Pickup
Input Errors on page 167.
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Status message Description

PUnumber: Faulty Signal. Signal

period (x, events counted y) is
too small compared to previous
signal period (2).

PUnumber: Index mark missing.

PUnumber: Missing index.

PUnumber: Missing Signal.
Signal period (x, events counted
y) is too great compared to
previous signal period (2).

PUnumber: Missing Signal.
Signal timeout occurred (events
counted x).

PUnumber: No index mark
found.

PUnumber: No signal.
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The pickup (PUnumber) is supplying a faulty signal. Signal
period (x, events counted y) is too small compared to
previous signal period (2). Check the pickups and the
corresponding configuration (see Engine — Pickups -
General on page 98). Furthermore, also pay attention to the
instructions in the section entitled Pickup Input Errors on
page 167.

Index mark missing for pickup (PUnumber). Check the
pickups and the corresponding configuration (see Engine —
Pickups — General on page 98). Furthermore, also pay
attention to the instructions in the section entitled Pickup
Input Errors on page 167.

Index missing for pickup (PUnumber). Check the pickups
and the corresponding configuration (see Engine — Pickups
— General on page 98). Furthermore, also pay attention to
the instructions in the section entitled Pickup Input Errors
on page 167.

Signal missing for pickup (PUnumber). Signal period (x,
events counted y) is too large compared to previous signal
period (2). Check the pickups and the corresponding
configuration (see Engine — Pickups — General on page 98).
Furthermore, also pay attention to the instructions in the
section entitled Pickup Input Errors on page 167.

Signal missing for pickup (PUnumber). Timeout occurred
(events counted until timeout x). Check the pickups and the
corresponding configuration (see Engine — Pickups —
General on page 98). Furthermore, also pay attention to the
instructions in the section entitled Pickup Input Errors on
page 167.

Could not find index mark for pickup (PUnumber). Check
the pickups and the corresponding configuration (see
Engine — Pickups — General on page 98). Furthermore, also
pay attention to the instructions in the section entitled
Pickup Input Errors on page 167.

The pickup (PUnumber) is not supplying a signal. Check the
pickups and the corresponding configuration (see Engine —
Pickups — General on page 98). Furthermore, also pay
attention to the instructions in the section entitled Pickup
Input Errors on page 167.
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Status message

PUnumber: Number of events (x)
counted on pickup input
PUnumber does not the match
the expected value (y).

PUnumber: Operational error.

PUnumber: Polarity detection
failed.

PUnumber: Synchronization
problem.

PUnumber: Wrong pickup signal
polarity on pickup input
PUnumber detected. Reversing
polarity internally.

£ MOTORTECH

Description

For the pickup (PUnumber) the number of events (x)
counted on pickup input number does not the match the
expected value (y). Check the pickups and the
corresponding configuration (see Engine — Pickups —
General on page 98). Furthermore, also pay attention to the
instructions in the section entitled Pickup Input Errors on
page 167.

An operational error occurred at pickup (PUnumber). Check
the pickups and the corresponding configuration (see
Engine — Pickups — General on page 98). Furthermore, also
pay attention to the instructions in the section entitled
Pickup Input Errors on page 167.

Polarity detection failed for pickup (PUnumber). Check the
pickups and the corresponding configuration (see Engine —
Pickups - General on page 98). Furthermore, also pay
attention to the instructions in the section entitled Pickup
Input Errors on page 167.

A synchronization error occurred at pickup (PUnumber).
Check the pickups and the corresponding configuration
(see Engine — Pickups — General on page 98). Furthermore,
also pay attention to the instructions in the section entitled
Pickup Input Errors on page 167.

Wrong polarity of pickup (PUnumber) detected at pickup
input PUnumber. Reversing polarity internally. No
additional action required.

Self test aborted because pickup Self test aborted because pickup signals have been

signals have been detected on
pickup input PUnumber.

Speed (x RPM) exceeded
overspeed limit (y RPM) at
trigger signal number.

Temperature of device (x °C)
exceeded error threshold limit

v °0.

Rev. 09/2019

detected on pickup input PUnumber. Self test can only be
carried out when engine is at a standstill (see Self Test on
page 78).

Potential causes:

— Interference coupling on pickup signal

— Engine was started

The speed (x RPM) exceeded overspeed limit (y RPM) at
trigger signal number (see Engine — Pickups — General on
page 98). The reason for this may also be an interference
coupling on the trigger signal.

The temperature of the device (x °C) exceeded failure
threshold (y °C). Ensure that there is sufficient air
circulation and/or cooling.
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Status message Description
Temperature of device (x °C) The temperature of the device (x °C) exceeded warning
exceeded limit (y °C). threshold limit (y °C) for more than two minutes. Ensure

that there is sufficient air circulation and/or cooling.

Temperature of device (x °C) The temperature of the device (x °C) exceeded warning
exceeded permanent limit (y °C). threshold limit (y °C) for more than ten minutes. Ensure
that there is sufficient air circulation and/or cooling.

Temperature sensor failed. The temperature sensor has failed. Restart the ignition
controller. If the error occurs again after restarting the
device, please contact MOTORTECH.
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8.12.6 Runtime Data — Message Log

M! MICT - Runtime Data =&
= ] T
=P JORURC
| Overview | Tming | lgnton | BankA | BankB | States | Messagelog tcs | Temperatures
Operating Hours Time Category Message -

41:22:17.519 2016-06-09 12:18:51 Infe  CANopen oninterface CAN2 changed state to "Reset communication
2016-06-09 12:18:51 Info  CANopen on interface CAN2 changed state to "Pre-operational”.
2016-06-09 12:18:51 Info  J1939 on interface CANL changed state to "Start succeeded”.
2016-06-09 12:23:21  Infe  Device switched off.

2016-06-00 13:2:224 Info  Device (firmware 0.0.1.27867) started at a supply voltage of 233 V.
2016-06-09 13:29:24  Infe  J1939 on interface CANL changed state to "Enter”.

2016-06-09 13:29:24 Info  CAMopen on interface CANZ changed state to “Initialising™.
2016-06-09 13:29:24 Info CANopen cn interface CAN2 changed state to “Reset application”,
2016-06-09 13:20:24 Info  CANopen on interface CAN2 changed state to "Reset communication
2016-06-09 Info  CAMNopen on inteface CAM2 changed state to "Pre-operational”.
2016-06-09 Info  J1939 on interface CANL changed state to “Start succeeded”.
2016-06-09 Infe  Cenfiguration changed.

2016-06-09 13:31:05  Alarm Al alarms reset.

2016-06-09 13:3309 Info  Configuration changed.

2016-06-09 13:33:09 Alarm  All alarms reset.

2016-06-09 13:34:55 Info  Configuration changed.

2016-06-09 13:34:55  Alarm Al alarms reset.

2016-06-09 13:3701  Info  Configuration changed.

2016-06-09 13:37:01  Alarm  All alarms reset.

2016-06-09 13:38:58  Info  Device switched off.

2016-06-13 07:55:37 Info  Device (firmware 0.0.1.27867) started at a supply voltage of 238 V.
2016-06-13 07:55:37  Infe  J1939 on interface CANL changed state to “Enter”.

2016-06-13 07:55:37  Info  CANopen on interface CAN2 changed state to “Initialising”.
2016-06-13 07:55:37 Infe  CANopen on interface CAN2 changed state to "Reset application”.
2016-06-13 37 Info  CAMopen on interface CAN2 changed state to "Reset communication
2016-06-13 07:55:37 Info CANopen on interface CAN2 changed state to “Pre-operational”,
2016-06-13 07:55:38  Info  J1930 on interface CANL changed state to "Start succeeded”.
2016-06-13 07:57:10 Infe  Configuration changed.

2016-06-13 07:57:10  Alarm Al alarms reset.

2016-06-13 07:57:34  Info  Configuration changed.

2016-06-13 Alarm  All alarms reset.

4 2016-06-13 07:57:47 Alarm  Alarm 2 "Drehzahl” triggered.

41:41:18126 2016-06-13 08:00:31 Infe  Cenfiguration changed.

41:41:18132  2016-06-13 08:00:31  Alarm Al alarms reset.

41:42:36.574  2016-06-13 08:01:50  Alarm  Alarm 2 "Drehzahl” triggered.

=]

=)

« il ] »
(2] tutomatec scroing

& COMS D MIC66x2.24 (1.6.1 [0002401]) Lifetime: 42:08:50.921

In the view Message Log, information, warnings, errors and alarms are listed.

Information, warnings and errors are specified by the ignition controller, while alarms can be
freely configured using the MICT. Refer to the section Inputs/Outputs — Alarms on page 108.

Errors and appropriately configured alarms shut down the engine.
The following information is provided:

— Operating Hours
Operating hours counter reading at the time of message

- Time
Date and time of the message (see following information box)
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Category
Type of message (information, warning, error, alarm)

Message
Message text; you can find more information on the message text in the following sections.

You have the following options:

132

Automatic scrolling
If this box is checked, the system automatically displays the last list entry until a new event
occurs.

Acknowledge Alarms

With this button, you can reset triggered alarms if they are no longer active. An alarm can
only be acknowledged if the checkbox Permanent — Keep output activated until alarm is
acknowledged in the alarm configuration is activated.

® Date and time of ignition controller

The date and time can be individually configured for each ignition controller

and saved in the device. The device does not adjust automatically for
daylight savings time. Hence, deviations may occur between the device
time and the time on the computer used to access the device.

Correspondingly, the times indicated for the states, messages, and in the
log reflect the time of the ignition controller. The current time of the ignition
controller is shown in the view Runtime Data — Information. You can adjust
the time of the ignition controller by entering the desired time in the menu
via Device -> Set date and time.

Acknowledging an operational error

While the engine is in standstill, there are the following options for
acknowledging operational errors:

— via Device ->» Send command -> Acknowledge operational error in the
MICT

— Restart / Reset

— Hold button PB on the controller longer than three seconds

Acknowledging warnings

You can acknowledge a warning by briefly pressing the pushbutton PB on
the controller.
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8.12.6.1 Information
Information

Access control disabled.

Access control enabled.

All access control PINs reset.

CAN interface CANnumber entered
bus off state.

CAN interface CANnumber left bus
off state.

CAN reset requested by
GPlnumber.

CANopen on interface CANnumber
changed state to "name".

Configuration changed.

Date and time set.

Device (firmware
number.number.number.number)
started at a supply voltage of x V.

Device reset requested by
GPlnumber failed because pickup
signals have been detected.

Device switched off.
Engine operating hours set to x h.

Failed to change PIN of access
control level "number".
Failed to disable access control.

Failed to enable access control.

Failed to reset all access control
PINs.

Rev. 09/2019
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Description

The Access control was disabled (see Access Control for
MICé6 on page 82).

The Access control was enabled (see Access Control for
MICé6 on page 82).

AlL PINs for access control were reset (see Access Control
for MIC6 on page 82).

The CAN interface CANnumber has entered Bus off state
(see Runtime Data — Diagnostics on page 141).

The CAN interface CANnumber has left the Bus off state
(see Runtime Data - Diagnostics on page 141).

A CAN reset was requested via general purpose input
GPlnumber (see Inputs/Outputs — Inputs on page 112).

The CANopen at interface CANnumber has changed state
to "name" (state of NMT State Machine according to CiA
DS 301).

The Configuration of device was changed (via the MICT or
via fieldbus).

The date and the time have been set.

The device (firmware number.number.number.number)
was started with a supply voltage of x V.

The device reset requested by GPlnumber failed because
pickup signals have been detected (see Inputs/Outputs —
Inputs on page 112).

The device was switched off.
The engine operating hours set to x h.

Failed to change PIN of access control level "number" (see
Access Control for MIC6 on page 82).

The access control could not be disabled (see Access
Control for MIC6 on page 82).

The access control could not be enabled (see Access
Control for MIC6 on page 82).

Failed to reset all PINs for access control (see Access
Control for MIC6 on page 82).
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Information

Firing disabled (Start/Stop In:
value, CAN: value, RS485: value)

Firing enabled (Start/Stop In:
value, CAN: value, RS485: value)

J1939 on interface CANnumber
changed state to "name".

One or more messages are lost
due to exhausted memory pool or
message queue overrun.

Operational error acknowledged.

PIN of access control level
"number" changed.

Self test denied because no
outputs are configured.

Self test started.
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Description

The firing is disabled, because at least one of the inputs
(start/stop input, CAN interface, RS485 interface) used for
the firing release is disabled. The inputs can have the
following values:

- enabled: Firing enabled
— disabled: Firing disabled
- n/a:notused

The firing is enabled, because all inputs (start/stop input,
CAN interface, RS485 interface) used for the firing release
are enabled. The inputs can have the following values:

— enabled: Firing enabled
— disabled: Firing disabled
— n/a:not used

J1939 on interface CANnumber changed state to "name".
Following statuses are possible:

- Enter/Start succeeded
The CAN mode /1939 or ALL-IN-ONE (J1939) was
started.

- Start failed
Initialization failed.

- Stop
Assignment of the Source Address was unsuccessful.
A different source address needs to be set in the
configuration (see Miscellaneous — Communication
on page 113).

- Leave
Left CAN mode /1939 or ALL-IN-ONE (J1939).

One or more messages were lost because there was
insufficient storage space or too many messages were
queued.

Operational errors are acknowledged.

PIN of access control level "number" changed (see Access
Control for MIC6 on page 82).

The self test could not be carried out because no outputs
are configured (see Self Test on page 78).

The self test was started (see Self Test on page 78).
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Information
Self test stopped.

Spark plug operating hours set to
xh.

Description

The self test was stopped (see Self Test on page 78).

The spark plug operating hours were set to x h.

Speed (x RPM) exceeded maximum Speed (x RPM) has exceeded the maximum speed (y RPM)

allowed speed (yRPM) at power-
on. Waiting for engine stop.
Wrong pickup signal polarity on
pickup input PUnumber detected.
Reversing polarity internally.

8.12.6.2 Warnings

during operation. The ignition controller is waiting for the
engine to stop.

Wrong pickup polarity detected at pickup input
PUnumber. Reversing polarity internally.

Contrary to errors, warnings do not result in the engine being shut down.

Warning

Configuration data checksum

error. Using default configuration.

Configuration invalid. Using
previous configuration.

Configuration of pickup set
number invalid.

Disable secondary diagnostic due
to output Anumber/Bnumber.

General warning number.

Rev. 09/2019

Description

The checksum of the configuration data is faulty. The
default configuration is used. This message may appear
during an upgrade/downgrade of the firmware. Check
your configuration data and the MICT version being used.
Then download the configuration to the device once
again.

The configuration is invalid. The previous configuration is
used. This message may appear during an
upgrade/downgrade. Check your configuration data and
the MICT version being used. Then download the
configuration to the device once again.

The configuration of the pickup set is invalid. Check the
configuration of the pickups (see Engine — Pickups —
Inputs on page 100).

Secondary diagnosis disabled due to output

Anumber/Bnumber shut off. Check the ignition coil and
wiring at the corresponding output.

General warning number. An undefined warning has
occurred. If this occurs repeatedly, please contact
MOTORTECH.
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Warning Description

Incompatible coil parameters Incompatible coil parameters received. The secondary
received, secondary voltage voltage diagnostics have been disabled. This message
diagnostics disabled. may appear during an upgrade/downgrade. Check your

configuration data and the MICT version being used. Then
download the configuration to the device once again.

Invalid coil data received. Invalid coil data received. This message may appear
during an upgrade/downgrade. Check your configuration
data and the MICT version being used. Then download the
configuration to the device once again.

Pickup configuration invalid. The pickup configuration is invalid. This message may
appear during an upgrade/downgrade. Check your
configuration data and the MICT version being used. Then
download the configuration to the device once again.

Power output (x W) exceeded limit  The power output (x W) exceeded warning threshold limit

(y W) at a supply voltage of z V. (y W) for longer than two minutes at a supply voltage of
zV.

Speed (x RPM) exceeded Speed (x RPM) exceeded overspeed limit (y RPM).

overspeed limit (y RPM). Previous  Previous speed was z RPM (see Engine — Speed Settings

speed was z RPM. on page 97). The reason for this may also be an
interference coupling on the trigger signal.

Temperature of device (x °C) The temperature of the device (x °C) exceeded warning

exceeded limit (y °C) threshold limit (y °C) for more than two minutes. Ensure

that there is sufficient air circulation and/or cooling.

8.12.6.3 Alarms
Alarms can be defined in the configuration. When doing so, each alarm is assigned a number
(see Inputs/Outputs — Alarms on page 108).

Alarm Description

Alarm number "“description" The alarm number "description" was acknowledged.
acknowledged.

Alarm number "description" The alarm number "description" was triggered.
triggered.
All alarms reset. All alarms reset.
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8.12.6.4 Failure

£ MOTORTECH

All system or operational errors cause the engine to be shut down.

Error

Alarm shutdown caused by alarm
number.

Assertion failed (x).

Critical error x (y).

Current sensor of output bank
name failed.

Cycle signal was missing, so more
trigger signals were counted than
available per cycle.

Device started after supply voltage
failure.

General error number.

General error in pickup pre-
processing on pickup input
PUnumber.

Number of trigger signals
(number) counted does not match
the configured value.
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Description

The engine was shut down by alarm number. This
function was defined in the configuration (see
Inputs/Outputs — Alarms on page 108).

An assertion was not adhered to (x). For example, an
assumption for a value was not fulfilled in the firmware. If
the error occurs again after restarting the device, please
contact MOTORTECH.

Critical error x (y). If the error occurs again after restarting
the device, please contact MOTORTECH.

The current sensor of output bank name failed. Restart
the ignition controller. If the error occurs again after
restarting the device, please contact MOTORTECH.

Cycle signal was missing, so more trigger signals were
counted than available per cycle. Check the pickups and
the corresponding configuration (see Engine — Pickups —
General on page 98). Furthermore, also pay attention to
the instructions in the section entitled Pickup Input Errors
on page 167.

The device was started after a failure of the supply
voltage. Please check the power supply of the device
where applicable.

General error number. An undefined error has occurred.
Restart the ignition controller. If the error occurs again
after restarting the device, please contact MOTORTECH.

General error in pickup pre-processing on pickup input
PUnumber. Check the pickups and the corresponding
configuration (see Engine — Pickups — General on page
98). Furthermore, also pay attention to the instructions in
the section entitled Pickup Input Errors on page 167.

Number of trigger signals (number) counted does not
match the configured value. Check the pickups and the
corresponding configuration (see Engine — Pickups —
General on page 98). Furthermore, also pay attention to
the instructions in the section entitled Pickup Input Errors
on page 167.
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Error Description

Operational error caused by An operational error was caused by pickup signals
pickup signals. PU1=x, PU2 =, (pickup PU1 = x, pickup PU2 =y, pickup PU3 = 2).

PU3=2. For information on the numbers shown, please consult

the documentation on the pickup status bits on the
storage device enclosed with the ignition controller. You
can open the file via the menu: Documentation -> More
information.

Check the pickups and the corresponding configuration
(see Engine - Pickups — General on page 98).
Furthermore, also pay attention to the instructions in the
section entitled Pickup Input Errors on page 167.

Output board identification failed  The identification of the output board failed due to a

due to a checksum error. checksum error. Restart the ignition controller. If the error
occurs again after restarting the device, please contact
MOTORTECH.

Output board identification failed  The identification of the output board failed due to

due to incompatible hardware. incompatible hardware. Restart the ignition controller. If
the error occurs again after restarting the device, please
contact MOTORTECH.

Output board identification failed  The identification of the output board failed due to

due to missing data. missing data. Restart the ignition controller. If the error
occurs again after restarting the device, please contact
MOTORTECH.

Output board identification failed  The identification of the output board failed due to

due to unknown error number. unknown error number. Characteristic data of the output
board could not be read, they are defective or do not
match the device. Restart the ignition controller. If the
error occurs again after restarting the device, please

contact MOTORTECH.
Output board identification failed  The identification of the output board failed due to
due to unknown hardware. unknown hardware. Characteristic data of the output

board could not be read, they are defective or do not
match the device. Restart the ignition controller. If the
error occurs again after restarting the device, please
contact MOTORTECH.

Power failure detected on output Power supply fault in output board caused by output

Anumber/Bnumber. Anumber/Bnumber was detected. Restart the ignition
controller. If the error occurs again after restarting the
device, please contact MOTORTECH.
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Error Description

Power output (x W) exceeded error  The power output (x W) exceeded failure threshold (y W)
threshold limit (y W) at a supply at a supply voltage of z V.
voltage of z V.

Power output (x W) exceeded The power output (x W) exceeded warning threshold limit
permanent limit (y W) ata supply (v W) for longer than three minutes at a supply voltage of
voltage of z V. zV.

Self test aborted because pickup  Self test aborted because pickup signals have been

signals have been detected on detected on pickup input PUnumber. Self test can only be
pickup input PUnumber. carried out when engine is at a standstill (see Self Test on
page 78).

Potential causes:
— Interference coupling on pickup signal

— Engine was started

Speed (x RPM) exceeded The speed (x RPM) exceeded overspeed limit (y RPM) at

overspeed limit (y RPM) at trigger  trigger signal number (see Engine — Pickups — General on

signal number. page 98). The reason for this may also be an interference
coupling on the trigger signal.

Supply voltage failure. Supply voltage failure. Please check the power supply of
the device where applicable.

Temperature of controller board The temperature of controller board (x °C) exceeded limit

(x °C) exceeded limit (y °C). (y° ©). Ensure that there is sufficient air circulation and/or
cooling.

Temperature of device (x °C) The temperature of the device (x °C) exceeded failure

exceeded error threshold limit threshold (y °C). Ensure that there is sufficient air

Wy °0). circulation and/or cooling.

Temperature of device (x °C) The temperature of the device (x °C) exceeded warning

exceeded permanent limit (y°C).  threshold limit (y °C) for more than two minutes. Ensure

that there is sufficient air circulation and/or cooling.

Temperature of output board (x°C) The temperature of output board (x °C) exceeded limit
exceeded limit (y °C). (v °0). Ensure that there is sufficient air circulation and/or
cooling.

Temperature sensor of controller ~ The temperature sensor of controller board failed. Restart
board failed. the ignition controller. If the error occurs again after
restarting the device, please contact MOTORTECH.

Temperature sensor of output The temperature sensor of output board failed. Restart
board failed. the ignition controller. If the error occurs again after
restarting the device, please contact MOTORTECH.
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Error Description

Trigger period (x, triggers counted  The trigger period (x, triggers counted y) is not in

y) is not in acceptable range acceptable range compared to previous trigger period (2).
compared to previous trigger Check the pickups and the corresponding configuration
period (2). (see Engine - Pickups — General on page 98).

Furthermore, also pay attention to the instructions in the
section entitled Pickup Input Errors on page 167.

Trigger signal missing. Current The trigger signal is missing. Current trigger period
trigger period (triggers counted x)  (triggers counted x) is out of the specified range

is out of the specified range compared to the previous trigger period. Check the
related to the previous trigger pickups and the corresponding configuration (see Engine
period. — Pickups - General on page 98). Furthermore, also pay

attention to the instructions in the section entitled Pickup
Input Errors on page 167.
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8.12.7 Runtime Data — Diagnostics

M! MICT - Runtime Data =&
e o
BT - \ o
SR8 e =g
| Overview | Tming | lonton | BakA | BankB | States | Messagelog | Diagnostcs | Temperatues | Informaton
CAN State
CAN1 ) Error Active & Error Passive ) Bus Of
CAN2 & Error Active D Error Passive ) Bus Of
Controller Board
Supply Voltage [V]
I 00
0 10 20 0 e
Pickup Input 1 Pre-Trigger [V] Pickup Input 4 Pre-Trigger [V]
—_— I
-J'IYll['I'I-Il1l|;1||r]
0 2 4 6 3 10 [ H 4 & ] 10
Pickup Input 2 Pre-Trigger [V] Pickup Input 5 Pre-Trigger [V]
ji=——] ———2
L] 2 4 6 8 10 L] 2 4 & 8 10
Pickup Input 3 Pre-Trigger [V] Pickup Input & Pre-Trigger [V]
- 4 4400 I
-JIIYII[IIII-|IT||;T||11
0 z 4 6 3 10 [ H 4 5 ] 10
Aux Pickup Supply Voltage 1 [V] Aux Pickup Supply Voltage 2 [V]
1} —
- r T T T T T T T T T 1 - T T T T T T T T T ™
0 5 10 15 20 25 [ 5 10 15 20 25
Aux Analog Input Supply Voltage [V]
I —
T T T T T T T T T 1
0 8 10 15 20 25
Output Board
Power Output [W] -
& COMS D MIC66x2.24 (1.6.1 [0002401]) Lifetime: 42:08:42.921

The following information is provided:
— CAN State

MOTORTECH

The status display indicates the current error handling status of the device for the CAN bus

communication:

— Error Active

The device is in normal status of the bus communication. If an error occurs in the

communication, the device sends an active error flag.

— Error Passive

After a defined number of errors in the bus communication, the device changes to the
status Error Passive. If another error occurs, the device sends a passive error flag.
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142

Bus Off
The device is disconnected from the CAN bus due to error accumulations in the bus
communication.

Controller Board

Supply Voltage
Current voltage supply of the controller board.

Pickup Input Pre-Trigger Voltage

Current pre-trigger voltage for the pickup inputs (refer to Engine — Pickups — General on
page 98). During operation the pre-trigger voltage for passive pickups is increased
depending on the speed, so that the ignition controller is less prone to interferences.

Aux. Pickup Supply Voltage

Current auxiliary supply voltage of the pickups (refer to Engine — Pickups — General on
page 98)

Aux. Analog Input Supply Voltage

Current auxiliary supply voltage of the analog inputs (refer to Timing — Analog Inputs on
page 103)

Output Board

Power Output
Current output of the output board
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8.12.8 Runtime Data — Temperatures

£ MOTORTECH

M MICT - Runtime Data

=Sl

Y DEE

Overview | Tming | Igniton | BankA | BankB | States | Messagelog | Diagnosics | Temperatures | Informaton

Controller Board

Min Temp [°C) -
Max Temp [°C] -

Output Board

Max Temp [°C] -
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rFrriroversy 1
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@ COM6 1D MIC66:2.24 (1.6.1 [00024c01]) Lifetime: 42:08:34.921

In the window you receive an overview of the temperatures of the controller board and the
output board. The maximum and minimum values are reset at each new start of the ignition

controller.

The following information is provided:

— Controller Board

— Current Temp.

Current temperature of the controller board

- Min. Temp.

Minimum measured temperature of the controller board

- Max. Temp.

Maximum measured temperature of the controller board

Rev. 09/2019



I 8 Settings via the MICT

— Output Board

— Current Temp.
Current temperature of the output board

- Min. Temp.
Minimum temperature measured on the output board

- Max. Temp.
Maximum temperature measured on the output board

8.12.9 Runtime Data — Information

M! MICT - Runtime Data =&

= =d = | (@) G
1 3-=p-: JORUR

Overview | Tming | Igniton | BankA | BankB | States | Messagelog | D | Information |
Device

Device ID MIC6 6x2.24 (1.6.1 [00024¢01])

Arrangement Number 642.24 H000-000-AA-2

Serial Number 00000000

Bootloader Version 0.44.027522

Firmware Version 0.0.1.27867

Operating Hours 42:08:22.91

Controller Board

Serial Number CPU0000000IB

Hardware Version 0400

Qutput Board

Senial Number 00000000

Hardware Version 0.1.0.24123

Clack

Date and Time Monday, June 13, 2016 8:27:36 AM UTC

) COMS ID MICS 6x2.24 (161 [00024¢01)) Lifetime: 42:08:22921

In this view, you can find an overview of the device and version data. If problems arise, you can
print the current runtime data and send them to the MOTORTECH Service Department by fax or as
a PDF file by email. For fast support, we will then immediately have all required information.
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8.13 Log
g Click on the symbol to open the window Log. This window is only available to
D users with authorizations starting at the access level Advanced Service.

M MICT - Log = |8

) Automatic scroling Loglevel: [debug  ~
te log to file: nfa Select file |

12/9/15 1:44 PM /src/data_handler/dacta_handler.cpp (1506) Error setting tag 4351

12/9/15 1:44 PM /src/date_handler/data_handler.cpp (1502) Tried to set undefined tag 5152
12/9/15 1:44 PM /src/pickup_signal _handler/pickup signal handler.cpp (442) select inputs:
12/9/15 1:44 PM /src/pickup_signal_handler/pickup_signal handler.cpp (442) select inputs:
12/9/15 1:44 PM /src/pickup_signal handler/pickup signal handler.cpp (442) select inputs:
12/9/15 1:44 PM /src/pickup_signal handler/pickup_signal handler.cpp (442) select inputs:
12/9/15 1:44 FM /src/pickup_signal_handler/pickup_signal_handler.cpp (442) select inpucs:

R =
[P
oo oo

The window Log serves to support error diagnostics by MOTORTECH.

— Automatic scrolling
If the function is active, the view panel focuses on the latest message.

- Loglevel
The selection of the log level is specified by MOTORTECH if needed.

- Write log to file
This checkbox activates or deactivates, respectively, the saving of the logged datain a
selected file. If the function is disabled, the logged data are merely shown on the display.

— Selectfile
With this button, you can select a file to which you want to save the logged data.
If you are prompted to create a log file in the case of a service request, proceed as follows:
1. Open the window Log via the toolbar or the menu bar.
2. Select a path with the Select file button and enter the file name for the log file.

» Ifthe file does not yet exist, it is automatically created with the extension .log.

3. Activate the checkbox Write log to file.
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4. Select the level specified by MOTORTECH from the list Log level.

5. Leave the window open.

» The log messages are logged both in the window and in the selected file.

Date and time of ignition controller

The date and time can be individually configured for each ignition controller
and saved in the device. The device does not adjust automatically for
daylight savings time. Hence, deviations may occur between the device
time and the time on the computer used to access the device.

Correspondingly, the times indicated for the states, messages, and in the
log reflect the time of the ignition controller. The current time of the ignition
controller is shown in the view Runtime Data — Information. You can adjust
the time of the ignition controller by entering the desired time in the menu
via Device - Set date and time.

8.14 Runtime Adjustments

NOTICE

146

Click on the symbol to open the window Runtime Adjustments. This window is
only available to users with authorizations starting with access level Service.

Runtime adjustments are implemented directly

All runtime adjustments are implemented directly without requiring the
input to be confirmed and are retained even in the case of a MIC6 restart.
Changes that have been saved in the device configuration are only
displayed after re-uploading the device configuration in the MICT's main
window.
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8.14.1 Runtime Adjustments — Reset

P MICT - Runtime Adjustments =ujilEl

M e e e e
reset cran] [ ~ov

[ osaov | [ € o.00v| [(® o.xrer | [ B osrer |

D COM6 ID MIC6 6x2.24 (1.6.1 [00024<01])

The index/reset position can be corrected by 5 °crankshaft (advanced/retarded) while the device
is being operated. The correction is made with the buttons:

-  0.1ADV/RET
in 0.1° increments to advance or retard

- 0.5 ADV/RET
in 0.5° increments to advance or retard
Changes are implemented immediately and stored in the configuration provided in the device.

If the correction range is not sufficient, the reset/index position must be adjusted in the
configuration (refer to Engine — Pickups — General on page 98).
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8.14.2 Runtime Adjustments — Timing

P! MICT - Runtime Adjustments ==

il e el e
Tiring Correcton («crane] [ ~ov
Global Tming point [~cran<) [ EIRER A0V

[&ose0v] [ €000 [2 o.1rer | [Broseer |

QD COMS 1D MIC6 6:x2.24 (1.6.1 (00024c01])

The global ignition timing position can be corrected by 50 °crankshaft (advanced/retarded)
while the device is being operated. The correction is made with the buttons:

- 0.1ADV/RET
in 0.1° increments to advance or retard

- 0.5 ADV/RET

in 0.5° increments to advance or retard
The limit for the ignition timing set in the schedule (refer to Timing — Schedule A/B — General on
page 104) cannot be exceeded or not reached with the runtime adjustment.

The correction of the global ignition timing is immediately implemented and also remains in
place if the device is restarted. NOTICE: The configuration defined in the device is not changed.
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8.14.3 Runtime Adjustments — Energy

M MICT - Runtime Adjustments =filE)

Reset | Timing | Energy | Secondary Voltage Calbration | Secondary Short Calbration |

Schedule A (Biogas)
Spark Duration [us] -

(Ko ][ s ] [Drus|[Brow]

sparic ntensty [oa] [
(K-om][(€-1ma]  [Prima] [Brw0m]
schedien
searkouation <] [N
(oo [ €-us ] [Pt ] [Bsi0ms]
spark intensty (ma] [N
(&-oma][€-ama] [P rima][Brom]

& COM6 ID MIC66x2.24 (1.6.1 [00024<01])

£ MOTORTECH

The energy settings can be separately adjusted for both schedules. Changes are implemented

immediately and stored in the configuration provided in the device.

Spark Duration
- 4/-1ps

lengthen or shorten in microsecond increments
- +/-10s

lengthen or shorten in 10 ps increments

Spark Intensity
- +/-1mA

increase and decrease in milliampere increments
- +/-10 mA

increase or reduce in 10 mA increments

Rev. 09/2019
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8.14.4 Runtime Adjustments — Secondary Voltage Estimation Calibration

P! MICT - Runtime Adjustments

Al
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& COMS 1D MIC6 6x2.24 (161 [00024<01])

The secondary voltage estimation can be calibrated in this window when using ignition coils that
support this function:

A correction value without units can be set for the secondary voltage estimation for every output
to increase the accuracy of the secondary voltage estimation for each individual cylinder. This

allows, for instance, different cable lengths on the engine to be compensated.

The secondary voltage estimation should be calibrated under full load at a nominal speed. The
adjustment can be made using the relevant global or individual cylinder buttons. The value
range depends on the set ignition coil. 0.0 is set as the standard value for all cylinders.

Changes are implemented immediately and stored in the configuration provided in the device.
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8.14.5 Runtime Adjustments — Secondary Short Calibration

(M8 MICT - Runtime Adjustments =

Resex | Trmog. | Energy | Secondery Volmge Calbration | Secorelry Short Calbration |
Secondary Short Enable Voltage

Secondary Short Enable Voltage (k] ] S e )
Secondary Short Sensitivity
Secondary Short Sensitity ey
(o1 | [ fRoo | [k ocor ] [ ccoos]
[ L ] [ == 0,01 ] i == 0,001 ] [ == 0.0001 ]

@ COM6 ID MIC66x2.24 (1.6.1 [00024c01])

The starting voltage and sensitivity for the secondary short-circuit detection can be adjusted.

Changes are implemented immediately and stored in the configuration provided in the device.

Secondary Short Enable Voltage [kV]
Set the necessary average ignition voltage required to activate the secondary short-circuit
monitoring:

— The secondary short detection is always activated at a value of o kV.

— The secondary short detection is always deactivated at a value of 65.535 kV.

Secondary Short Sensitivity
The permitted value range depends on the set ignition coil.

Set the sensitivity of the short-circuit detection e.g. as follows:
— The sensitivity is high at a value of 0.98.

— The sensitivity is low at a value of 1.02.
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EXAMPLE

Adjust the sensitivity of the short-circuit monitoring

If a short-circuit is misdiagnosed at a sensitivity of 1.00, the sensitivity

must be set to 1.02.

If a short-circuit is not detected at a sensitivity of 1.00, the sensitivity must

be set to 0.98.

8. 15 Cylmder Individual Offsets

Service.

Click on the symbol to open the window Cylinder Individual Offsets. This
window is only available to users with authorizations starting with access level

¥ MICT - Cylinder Individual Offsets
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) COMS 1D MIC6 6x2.24 (16.1 [0002401])

The cylinder individual offset can be applied to the position of the timing point while the
controller is being operated. Offset via keys:

0.1 ADV/RET

in 0.1° increments to advance or retard

0.5 ADV/RET

in 0.5° increments to advance or retard

The adjustment option of this function is limited by the specified settings in the configuration.
Refer to the section Timing — Schedule A/B — General on page 104.
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Immediate execution of the changes

Please note that changes made to the timing point are executed
immediately at the next firing of the corresponding cylinder. The maximum
performed change per cycle is however limited by the corresponding setting
in the configuration. For this read Timing — Miscellaneous on page 107.

Save changes automatically

Please remember that changes to the ignition timing are saved
automatically.
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8.16 Schedule Curve
. Click on the symbol to open the window Schedule.

8.16.1 Schedule Curve — Simulation

M MICT - Schedule (=l -
[¥] smulation 35.0 BTDC fF
S0 tion b H
Potentiometer
0 60 30.0 BTDC
2 ) g0 0-00% % J s S
L B ]
0 100 25.0 BTDC 2
] e
] o
Analog Current Input -;- 1 A
w0 z 7 Fa b
; 20.0 BTDC 1+ 5 +
5 15 - 1
Q som B B
[
- i
0 2 £ all: . Y
£ 15.0 BTOC | i
Ainalog Voltage Tnput = /,/
4 [ 4 /_/
10.0 BTDC i
2 Afa o0 ¥ Jpi
2 =
[} 10 1
5.0 BTDC [ttt s S Fones
Schedue ]
© Schedule A ) Schedule B
AN 0.0 ATOC
-a-roc e [ [ [
0 500 1.000 1.500 2.000
Speed [RPM]
— MnTimng — MaxTimng — MinSpeed Curve Timing — Max Speed Curve Tming — Speed Curve @ Current speed
QD COMS6 1D MIC6 6:x2.24 (161 (00024<01))

The schedule curve visualizes the configurations of the schedules and simulates the influence of
the inputs over the speed range. With the optional input fields, you can switch between
schedule A and B. Changes made by turning the control buttons or entering the desired values
are displayed simultaneously.
- Simulation

The simulation is activated or disabled using the checkbox.

- Potentiometer
Simulation of a potentiometer(the standard version of the MIC6 has no potentiometer)
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— Analog Current Input
Simulation of the analog current input

- Control button for adjustments between the configured values (e.g. o mA and 20 mA)
- Field for manual input of the desired value in mA
- Displays the value in °crankshaft by which the timing is offset
- Analog Voltage Input
Simulation of the analog voltage input
- Control button for adjustments between the configured values (e.g. o V and 10 V)
— Field for manual input of the desired value in V
- Displays the value in °crankshaft by which the timing is offset
- Schedule A/B
Select between Schedule Aand B
— Timing Point

Displays the global ignition timing as it changes during the simulation.

While connected to the device, the ignition timing is simulated depending on the actual engine
speed and marked as @ in the diagram.
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8.16.2 Schedule Curve — Runtime Values
If the checkbox Simulation is unchecked, the Schedule curve window switches to the current

runtime data.

¥ MICT - Schedule

7] simulation

Runtime Values
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& COM6 ID MIC6 6x2.24 (1.6.1 [00024<01])

The following information is provided:

— Schedule

Displays the currently selected schedule.

- Left column: Potentiometer (the MIC6 has no potentiometer), Analog Current Input, Analog

Voltage Input

Displays the new calculated adjustment values for the potentiometer, current and voltage

input.

- Right column: Potentiometer (the MIC6 has no potentiometer), Analog Current Input, Analog

Voltage

Input Display of values supplied by the ignition controller for the potentiometer, current and

voltage input.

- Speed

Display of the current speed

- Timing Point

Displays the current global ignition timing.
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8.17 Coils
The MICT has a database with technical information on MOTORTECH ignition coils. Open the
database as follows:

Tools - Coils

You have the option of storing and printing information on the ignition coils present in the
database. For this purpose, the following functions are at your disposal in the toolbar in the
Coils window.

Symbol Function

Stores the information on the selected ignition coil in a format that is
appropriate for configuring the MIC6 via fieldbus.

Prints the selected coil data set.

Prints the selected coil data set as PDF file.

@: \Tﬁ}, m

Q‘ Opens the print preview.
Coils
— Device
Select an ignition controller.
- Coil

Select an ignition coil.

Select the correct ignition controller

The ignition coil data depends on the ignition controller used. Always select
the ignition controller for which you are using the coils in order to obtain
the correct data.
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8.17.1 General

("2 wacT - coits =l ]
Eile
= =d =
o 5545
Cols General | bin. Energy Linit Curve
Device: [MICE - ——
Col: [05.50.104 Name: 06.50.104
06.50.105 Coill Type 1d: 6
06.50.108 Data Version: 1
06.50.112
06.50.113
ME601-0205
MB8601-0206
M8601-0207
Secondary diagnostics avalable if max. breakdonn voltage 5 set in range 35kV to 97kV. Addbonaly it s
reguired that the energy lnvi is set sufficently high according to the min. energy it aurve,
Coil Parameters
Parameter Min. Max.
Max. Breakdown Voltage [kv] bt a7
Spark Intensity [mA] Erd 150
Secondary Voltage Estmation Calibration S 5
Secondary Short Sensitivity 09 L1
Details
The following information is provided:
- Name
Coil name
- Coil Type ID

Used to clearly identify the ignition coil

— Data Version

Shows data version of the ignition coil selected in the database. The data version of the
ignition coil configured in the ignition controller is displayed in the runtime data in the view
Ignition (refer to Runtime Data — Ignition on page 121). The Automatic Online Update should
be activated to ensure that the coil database always has the latest data sets. Additional
information on the online update is provided in the section Online Update Settings on

page77.
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£ MOTORTECH

Illustration of the ignition coil

Information on the conditions under which a secondary diagnosis is possible using the
displayed ignition coil.

Coil Parameters
The following information is provided:

Max. Breakdown Voltage [kV]

Displays the permitted value range for the maximum breakdown voltage in kV. The
maximum breakdown voltage is configured in the view Timing — Schedule A/B — Energy
(refer to Timing — Schedule A/B — Energy on page 106).

Spark Intensity [mA]

Displays the permitted value range for the spark intensity in mA. The spark intensity is
configured in the view Timing — Schedule A/B — Energy (refer to Timing — Schedule A/B -
Energy on page 106).

Secondary Voltage Estimation Calibration

Displays the permitted value range for the secondary voltage estimation calibration. The
calibration of the secondary voltage estimation takes place in the view Engine — Ignition
Coils (refer to Engine — Ignition Coils on page 95) and in the runtime adjustments (refer to
Runtime Adjustments — Secondary Voltage Estimation Calibration on page 150).

Secondary Short Sensitivity

Displays the permitted value range for the calibration of the secondary short sensitivity. The
calibration of the secondary short sensitivity takes place in the view Engine — Ignition Coils
(refer to Engine — Ignition Coils on page 95) and in the runtime adjustments (refer to Runtime
Adjustments — Secondary Short Calibration on page 151).
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8.17.2 Min. Energy Limit Curve

8 MICT - Coils =l ]
Eile
= =4 =
o 553
G | General ‘ Min, Energy Limit Curve
Device: IW“ '] Min. Energy Limit Curve
Col: | 05.50.104 | 300
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M3601-0205 250
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Min, Energy Limit [m3J]
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T T T T
15 20 25 30 35 40 45 50
Max. Breakdown Voltage [kV]

= Min. Energy Limit 1 Min./Max. Limit Secondary Diagnostics

Min. Energy Limit Curve

The curve provides information on the energy in m) necessary to achieve a certain maximum
breakdown voltage in kV. The two vertical bars show the breakdown voltage area, in kV, in which
a secondary diagnosis is possible. The corresponding energy settings can be found in the view
Timing — Schedule A/B - Energy (refer to Timing — Schedule A/B — Energy on page 106).

When printing the coil data set, the curve values are also provided as a list.
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9.1 Start-up

Before you start up the MIC6 ignition controller, take note of the following:

Were the correct engine, ignition sequence, and output configuration selected? If you are
unsure, contact MOTORTECH or the corresponding engine manufacturer.

Ensure that the firing order of the engine and/or the wiring of the output cable harness are
carried out correctly.

Is the wiring of all pickups compliant with the drawings given in this operating manual?

Are the distances of the pickups to trigger discs, reluctor pins, etc. correctly set (see chapter
Determine the Installation Location of the Pickup on page 36)?

Ensure that the data were transferred flawlessly to the controller.

Check whether the start/stop input is set to Firing Active, or whether it works according to
the control requirements of the master control.

Check whether the input contact for parameter settings A/B (Schedule A/B) functions and
ensure that the correct schedule (A or B) was selected for start-up.

Close the service screw after completing the installation and configuration.

Ensure that no gas is present in the inlet and exhaust systems before you start the engine.
Ensure that the gas valve is closed.

Perform the normal engine start-up process while the gas valve is closed (start only).

Connect a stroboscope to the first firing cylinder (cylinder #1) and check whether the timing
point set on the ignition controller coincides with the actual timing point on the crankshaft.
If the ignition timing does not coincide exactly, change it (see chapter Runtime Data on page
116) until the optimal setting is reached. If the ignition does not fire, read the instructions in
section Troubleshooting on page 168.

Check all other cylinders for correct ignition. If they are not correct, stop the engine, and
recheck wiring and ignition sequence for correctness.

Stop the starting process. If no problems occur, start the engine in accordance with the
specifications of the engine manufacturer.

If a redundant pickup system is to be used, make sure that after the last configuration the
second pickup set has been synchronized at least once correctly so that the reset of the
second pickup set has been stored.

9.2 Shutdown

The ignition controller is shut down by disconnecting it from the power supply.
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9.3 Firmware Update
Using the MOTORTECH Flash Tool, you can update the firmware of the ignition controller. The
program is provided on the storage device (USB flash drive or CD-ROM supplied).

Install MOTORTECH Flash Tool
Install the MOTORTECH Flash Tool as follows:

1.

162

Start the installation:

Via the menu:

Start the file Start.exe on the storage device. Start the installation routine for the
MOTORTECH Flash Tool via Software ->» MOTORTECH Flash Tool -> Install MOTORTECH
Flash Tool.

Directly from the storage device:

Start the installation routine of the MOTORTECH Flash Tool directly. It is on the storage
device in the subdirectory Installation and for example named as follows: MOTORTECH-
Flash-Tool-0.9.00003-setup.exe.

Install the program.
Follow the instructions of the installation routine. Note that the license agreement terms
must be accepted before using the MOTORTECH Flash Tool.

If the USB driver is not yet installed, also install it via the menu or directly from the storage
device.

Via the menu:
Software -> USB Drivers -» Install USB Drivers

Directly from the storage device:
Start the exe file in subdirectory Drivers
(e.g. CDM v2.10.00 WHQL Certified.exe).

The MOTORTECH Flash Tool is set up. You can now connect your computer to the ignition
controller via the USB interface.
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Menu Bar and Toolbar
After launching the MOTORTECH Flash Tool, the following functions are available to you via the
icons on the toolbar and the entries in the menu bar:

=

£ & @

File -> Open

File -> Quit

View -> Extended file information
view

View -> Extended connection
settings

View -> Reload file

Device -» Search devices

Device -» Flash device

Settings -»> Language

Help -»> Help

Help -> About MOTORTECH Flash
Tool

Start Firmware Update

Rev. 09/2019
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Opens a firmware file.

Exits the program.

Fades in / out additional information of the
firmware file.

Fades in / out additional information and
settings of the connection to the device.

Reloads the file information of the selected
firmware file.

Restarts the search for connected devices.

Starts the update process or downgrade
process.

Opens the window Select Language in
which you can change the interface
language of the program.

Opens the online help function.

Opens detailed information on the
program.

Access control for firmware update

If you have activated the access control for the ignition controller, you need
the PIN for the level Master for the firmware update. For more information
read the section Access Control for MIC6 on page 82.
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® Backup the existing configuration

Your device's configuration may be lost if the firmware update is not
. performed properly. Always backup the existing configuration via the MICT
prior to performing an update. For more information read the section
Working with Configurations on page 84.

To start a firmware update, proceed as follows:

1.

2.

164

If an MICT is connected with the ignition controller, disconnect this connection.

Start the MOTORTECH Flash Tool via Start -> Programs ->» MOTORTECH -» MOTORTECH Flash
Tool -» x.x.x (e.g. 0.9.00003) -> MOTORTECH Flash Tool.

» The MOTORTECH Flash Tool will now start.

» The software automatically checks all ports for connected devices.

In the Status section under Device, check if your device has been recognized properly.

» If the MOTORTECH Flash Tool does not recognize a device that is connected to your
computer via the USB interface, you can usually still carry out a firmware update. To do
so0, observe the instructions in the information windows of the MOTORTECH Flash Tool
for the following steps.

Select in area File using the Select button the desired update file.

By reading the displayed file information, ensure that the update file is correct for your
device.

Start the update process using the Flash button or using the menu or toolbar.

» Theignition controller is restarted automatically.

» Now, a window opens informing you about the firmware version currently used on your
ignition controller and also about the relevant update version.

Confirm with Yes to proceed with the update process.

> Now the update will start.

> If the firmware update was successful, you will see a relevant message.

After a successful firmware update, check all configuration data.

® Downgrade process

The process for a downgrade is largely the same as the update process. You
will only be informed that a new firmware has been installed on the device.
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NOTICE

Rev. 09/2019

Help with connection problems

If a correctly connected device is not found during the automatic search,
this can, for example, be because too many communication interfaces are
assigned and must be checked. In this case, an interface from the drop-
down list Port in the area Connection can be selected and thus specified.

If the desired port is not yet displayed in the list or if the problem should
continue, an adjustment of the time-outs for the connection helps. The
time-out settings are displayed in the main view by the following entry in
the menu bar: View -» Extended connection settings

Enter the following settings:

— Update Request Timeout
Adjustment range: 1,000 ms to 10,000 ms, standard value: 3,000 ms.
An extension of the time-out can be an advantage, especially with
connection problems that occur because the computer has many
assigned ports.

— Time-out for the Start
Adjustment range: 1,000 ms to 10,000 ms, standard value: 3,000 ms. A
time-out change can be an advantage, especially with connection
problems that occur because the communication between the computer
and the device has been interrupted.

£ MOTORTECH
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10.1 Possible Faults
The MIC6 ignition controllers include several safety functions that can shut down the engine in
case of fault:

— Overspeed protection

- External shut-down contact (Start/Stop)

- Misfire detection (primary)

— Internal failure of the high voltage supply

— Output Error Detection

- Shutdown in the case of a faulty pickup or faulty pickup signals.
- Alarms

- Faulty voltage supply

— External EMI signals

10.2 Causes of Faults

10.2.1 Overspeed

The engine speed has exceeded the set overspeed value. As of firmware version 1.1.00000, an
operating error caused by overspeed is indicated on the device by the status LED flashing four
times (4 times red/off 250 ms, 750 ms off). Refer to the section LED Functions on page 29.

Potential Causes
- Speed controller does not function properly
—  Fuel supply to engine is not optimal.

— Faulty pickup signal
10.2.2 Output Error Detection
An internal failure of the high voltage supply or a defective output switch occurs.

Potential Causes
— Hardware fault on the MIC6

- Defectin the wiring (short circuit or open circuit)
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10.2.3 Misfire Detection (Primary)
Misfiring due to an open circuit on the primary side was detected and displayed in the runtime
data.

Potential Causes
— Defect in the output wiring

— Ignition coil defective

10.2.4 Pickup Input Errors

Faulty input signals from the pickups are detected. As of firmware version 1.1.00000, a pickup
input error is indicated on the device by the status LED flashing twice (2 times red/off 250 ms,
750 ms off). Refer to the section LED Functions on page 29.

Potential Causes
- Number of teeth on the flywheel does not match the set number.

— Damage to or uneven running of trigger disc
— Interference in the wiring of the pickup

—  Wiring of the pickup incorrect

- Distance of the pickup incorrect

— Dirton the pickup

Troubleshooting for Possible Causes

You will find information on possible causes of a pickup input error in the windows Runtime Data
— States (see Runtime Data — States on page 124) and Runtime Data — Message Log (see Runtime
Data — Message Log on page 131). When analyzing the messages shown there, please note that
the number of the pickup (e.g. PU2) only names the pickup at which the error or problem was
identified. Hence, this does not mean that this particular pickup also caused the problem. For
example, if the pickup PU1 is defect, it is entirely possible that, under certain circumstances, the
problem may only be identified at pickup input PU2.

For information on the numbers shown in the error messages (e.g. PU1=0x00001002), refer to
the documentation on the pickup status bits on the storage device enclosed with the ignition
controller. You can open the file via the menu: Documentation -> More information.

For a more in-depth analysis of the problem, the pickup traces may support you. Refer to the
section Pickup Trace on page 79. Compare the signals recorded there with the pickup settings in
your configuration (see Engine — Pickups — General on page 98).
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10.2.5 Acknowledging Faults

While the engine is shut down, you have the following options for acknowledging operational
errors:

— Use Error Acknowledge in the MICT
- Acknowledgment of the error via CAN bus or RS485
- By disconnecting the supply voltage

— Hold button PB on the controller longer than three seconds

10.3 Troubleshooting

10.3.1 Running a Self Test

You can run the self test via the MICT to check the order of the wiring and the connection
between the ignition controller outputs and the spark plugs. For this refer to section Self Test on
page 78.

Operational safety!

If you carry out a self test, it is essential for the gas supply to be switched
off and no more residual gas is left in the combustion chamber. Non-
compliance can result in damage to equipment or injury to persons.

10.3.2 Customer Service Information
You can reach our customer service during business hours at the following phone and fax
number, or by email:

Phone: 449514193990

Fax: +49 514193 99 99
Email: service@motortech.de
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10.3.3 Returning Equipment for Repair/Inspection
To return the device for repair and inspection, obtain a return form and return number from
MOTORTECH.

Fill out the return form completely. The completely filled out return form guarantees fast,
uncomplicated processing of your repair order.

Send the device and the return form to one of the two addresses below or to the nearest
MOTORTECH representative:

MOTORTECH GmbH MOTORTECH Americas, LLC
Hogrevestr. 21-23 1400 Dealers Avenue, Suite A
29223 Celle New Orleans, LA 70123
Germany USA

Phone: 449514193990 Phone: +1504 3554212
Fax: +49 514193 99 98 Fax: +1 504 355 4217
www.motortech.de www.motortechamericas.com
motortech@motortech.de info@motortechamericas.com

10.3.4 Instructions for Packaging the Equipment
For return shipment, equipment should be packaged as follows:

- Use packaging material that does not damage the equipment surfaces.
-  Wrap the equipment with sturdy materials and stabilize it inside the packaging.

— Use sturdy adhesive film to seal the packaging.
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11.1 Maintenance Instructions
Please follow the following maintenance instructions:

— Do not use caustic liquids or steam cleaners for cleaning the device.
— Clean the passive pickups at regular intervals.
- Check the ignition wires at regular intervals.

- Replace the pickups at regular intervals if operating them under elevated temperature
conditions (> +90 °C / > +194 °F).

- Regularly inspect all wires of the ignition system for damage and replace the wires as
needed.

- Check all plug-in connections for proper condition.
- Service the spark plugs as per the instructions of the spark plug and engine manufacturers.
— Observe the required tightening torques:

- All Mg bolts: 0.8 Nm to 1 Nm (0.6 lb-ft to 0.7 lb-ft)

- PG screw joints: 4.5 Nm to 5 Nm (3.3 lb-ft to 3.6 lb-ft)

- Service screw: 2.5 Nm to 3 Nm (1.9 lb-ft to 2.2 b-ft)

11.2 Spare Parts and Accessories
For spare parts and accessories for MIC6 ignition systems, please refer to our current product
guide, which is available for download on the Internet at www.motortech.de.
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